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Computer–0 Computer–1
1. Know About Computer 1. Computer...A Machine

Let’s Do Something Let’s Do Something

A. 1. (a), 2. (c), 3. (a) A.      used to take us from one place to another 
place,        Used to draw pictures,      Used to get B. 1. (T), 2. (F), 3. (F), 4. (T)
cool air,       used to watch movies,      used to 

Activity Time
keep vegetables fresh.

  Mouse,                 Keyboard,
B. 1. man-made, 2. life, 3. electricity, 4. pictures

        CPU,              Monitor
C. 1. FAST, 2. TIRED, 3. SUMS, 4. MISTAKES,

5. TIME2. Uses of Computer

D. 1. Machine is a man-made thing which is made to Let’s Do Something
save our time and to make our work easy.A. 1. (b), 2. (a), 3. Schools, Banks, Hospitals, 

2. Computer is a machine which runs on Airports
electricity.B. 1. (T), 2. (F), 3. (F), 4. (T)

3. Computer helps us to do many useful tasks.Activity Time
4. (a) Cooler, (b) Mobile, (c) Refrigerator,

Hospital                ,   Bank               ,  School (d) Air-conditioner.

Activity Time3. Hardware and Software
(a) MACHINE, (b) COMPUTER,Let’s Do Something
(c) NATURAL, (d) FAST, (e) PICTURE

A. 1. (a), 2. (b), 3. (c)
2. Uses of ComputerB. 1. (T), 2. (F), 3. (F), 4. (T), 5. (T)

Let’s Do SomethingActivity Time
A. 1. (b), 2. (c), 3. (a), 4. (b)Hardware—Mouse, Keyboard, Car
B. 1. (T), 2. (F), 3. (F), 4. (T)Software—Songs, Driving Rules, Windows
C. 1. In hospitals, computer help doctors to find out 4. Keyboard and Mouse

diseases and in operations.
Let’s Do Something

2. In schools, computers are used to educate the 
A. 1. (b), 2. (a), 3. (c), 4. (c) children.
B. 1. (T), 2. (F), 3. (T), 4. (F) 3. Bank, School, Railway Station, Shop
Activity Time Activity Time

Do yourself. A. Do yourself.

5. Windows and Internet B. BANK, SCHOOL, COMPUTER, HOSPITAL, 
HOMESLet’s Do Something

3. Parts of a ComputerA. 1. (a), 2. (c), 3. (c), 4. (c)

B. 1. (F), 2. (T), 3. (T), 4. (F), 5. (T) Let’s Do Something

C. 1. Desktop, 2. left, 3. computers, 4. Internet A. 1. (b), 2. (a), 3. (c), 4. (b)
Explorer B. 1. (T), 2. (T), 3. (F), 4. (F)

Activity Time C. 1. A computer mouse looks like a real mouse. It 
My Document       ,   My Computer        , has two or three buttons.

Internet Explorer       ,  Recycle Bin 2. A printer prints results on paper.
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3. CPU stands for Central Processing Unit.

4. Monitor, Keyboard, CPU, Mouse

Activity Time

Do yourself.

4. Knowing Keyboard

Let’s Do Something

A. 1. (c), 2. (a), 3. (c), 4. (b)

B. 1. (T), 2. (F), 3. (T), 4. (F)
Activity TimeC. Do yourself.

Do yourself.D. 1. A keyboard has five types of keys.

7. Introduction to Paint2. Keyboard is an input device which is used to 
type words and numbers on a computer. Let’s Do Something

3. (a) Arrow Keys, (b) Number Keys, A. 1. (c), 2. (a), 3. (b), 4. (a)
(c) Alphabetic Keys, (d) Function Keys.

B. 1. (T), 2. (T), 3. (F), 4. (F)
4. Alphabetic keys are used to write sentences.

C. 1. Paint
Activity Time

2. You can open the Paint program by following 
Do yourself. steps:

5. Using a Mouse Step 1 : Click on the Start button.

Step 2 : Choose All Programs.Let’s Do Something

Step 3 : Choose Accessories and click on A. 1. (c), 2. (b), 3. (b), 4. (a)
Paint.B. 1. (F), 2. (F), 3. (T), 4. (T)

3. Pencil tool is used to draw freehand drawing.C. 1. Computer mouse is a pointing device which is 
Activity Timeused to select and draw.

1. Fill with color tool, 2. Rectangle tool, 3. Pencil 2. Mouse pointer is an arrow on the screen.
tool, 4. Line tool, 5. Eraser tool.Activity Time

8. Storage DevicesDo yourself.

Let’s Do Something6. Operating the Computer
A. 1. (b), 2. (a), 3. (b), 4. (c)Let’s Do Something
B. 1. (T), 2. (F), 3. (T), 4. (F), 5. (T)A. 1. (c), 2. (b), 3. (b)
C. 1. Floppy disk is a magnetic disk. It is used for B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (F)

storing small quantity of information.
C. 1. Step 1 : Switch on the main switch for power 

2. The shape of CD is round.supply.
3. Hard disk is a storage device. It is fitted inside Step 2 : Now, switch on the power button of 

the CPU box.the UPS.
4. Pen drive is the latest storage device.Step 3 : Switch on the power button of the 
5. Hard disk is fitted inside the CPU box.monitor.

Activity TimeStep 4 : Finally switch on the CPU.

     Floppy Disk,            Pen Drive,2.

      Compact Disk,          Hard Disk 

Step 2 : From the menu that appears, select 
option Shut down. Now wait for some time till 
the computer turns off automatically.

Step 3 : Switch off the power button of the 
monitor.

Step 4 : Now, switch off the power button of 
the UPS.

Step 5 : Finally, switch off the main power 
supply.

Step 1 : Click on the Start button on the screen. 
A list of option will appear.
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results on the screen.9. Computer Lab Manners
2. Monitor, CPU, Keyboard, Mouse.Let’s Do Something

3. Microphone is used to record your voice, A. 1. (T), 2. (F), 3. (T), 4. (T), 5. (F)
music and sound in the computer. 

B. 1. (a) We should always keep the computer-room 
Activity Timeneat and clean. (b) We should follow the 

proper steps to switch ON the computer. A. 1. Mouse, 2. Monitor, 3. CPU, 4. UPS,
5. Keyboard2. We should not eat or drink in the computer lab.

B. Do yourself.3. Because the dust of the shoes is harmful for 
computers. C. Do yourself.

4. When we cover computer, we protect it from 3. How a Computer Works
dust.

Let’s Do Something
Activity Time

A. 1. (c), 2. (b), 3. (a), 4. (b)
Do yourself.

B. 1. (T), 2. (T), 3. (F), 4. (T)

C. 1. The calculations and making decisions are Computer–2
called processing.

1. Computer and Its Types
2. Output devices display the results on computer 

Let’s Do Something screen.
A. 1. (b), 2. (a), 3. (c), 4. (b) 3. Because all the processing and calculation in 
B.          Desktop Computer,           Laptop Computer, computer is done by CPU.

4. Input devices are used to feed data and           Palmtop Computer
instructions in computer.

C. 1. (F), 2. (T), 3. (F), 4. (T)
Activity Time

D. 1. Computer is an electronic machine which can 
A. Do yourself.perform many tasks quickly, easily and 

accurately. B. 1. Input, 2. Output, 3. Process, 4. Process,
5. Output2. A laptop computer is a kind of PC that can be 

used easily by carrying it from one place to 4. Keyboard and Its Functions
another.

Let’s Do Something
3. (a) Computer never gets tired or bored.

A. 1. (b), 2. (c), 3. (a), 4. (b)
(b) Computer’s storage capacity is very large. 

B. Do yourself.(c) Computer can do a number of jobs at the 
same time. C. 1. (F), 2. (T), 3. (T), 4. (F), 5. (T)

4. Desktop computer has more capacity. D. 1. Alphabetic keys are used to write a word or a 
sentence on computer screen.Activity Time

2. Backspace key is used to erase anything typed A. 1. DESKTOP,  2. COMPUTER,  3. PALMTOP,
on the left of the cursor.4. LIMITATIONS

3. Spacebar key is used to give blank space B. Do yourself.
between the words.

2. Parts of A Computer
4. Four cursor control keys are there on a 

Let’s Do Something keyboard.
A. 1. (c), 2. (b), 3. (b), 4. (a), 5. (c) Activity Time
B. 1. (F), 2. (T), 3. (F), 4. (T), 5. (F) A. Do yourself.
C. 1. Monitor looks like a TV. This device displays B. 1. Caps Lock key,
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2. Spacebar key, folder for storing data so it is useful for us.

3. Backspace key, Activity Time

4. Enter key. Do yourself.

5. Using Mouse 8. Save, Open, Print & Set as Wallpaper

Let’s Do Something Let’s Do Something

A. 1. (a), 2. (b), 3. (c), 4. (c) A. 1. (b), 2. (c), 3. (a), 4. (a)

B. 1. (F), 2. (F), 3. (T), 4. (T), 5. (T) B. 1. (F), 2. (T), 3. (T), 4. (F)

C. 1. Pointing device is used to select anything on C. 1. To save a file in Windows, follow these steps :
the monitor screen. Mouse is a pointing device.

2. To click, place the pointer on any icon, press 
the left mouse button once and release it. It 
will select an icon. This is known as clicking.

3. Press left mouse button on the icon. Keeping it 
pressed, move the mouse on the pad. This 
process is known as dragging.

Activity Time

Do yourself.

6. Let’s Paint

Let’s Do Something

A. 1. (c), 2. (a), 3. (a), 4. (b)

B. 1. (T), 2. (F), 3. (T), 4. (F)

C. 1. Pencil tool is used to draw freehand drawing.

2. Line tool is used to draw straight lines in Paint.

3. Fill with color tool is used to colour drawings.

Activity Time

A. (a) BRUSH, (b) PENCIL, (c) TEXT, (d) TOOL 
BOX,  (e) RECTANGLE

B. Do yourself.

7. Microsoft Windows 2007

Let’s Do Something

A. 1. (b), 2. (a), 3. (c), 4. (a), 5. (c)

B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (T)

C. 1. Operating System is a software program that 
provides an interface between user and the 
computer softwares.

2. In Windows operating system we can perform 
many functions like solving sums, playing 
movies, reading books, etc.

3. Desktop, icons, taskbar, start button, recycle 
bin and my documents are some components 
of Windows. 4. My documents is the personal 

Step 1 : Click on Office Button drop-down 
menu. Many options will be displayed.

Step 2 : Click on Save button.

Step 3 : Save As window will appear on the 
screen.

Step 4 : Type the name of the file in the File 
name text box.

2. To print a file, follow the given steps :

Step 1 : Click on Office Button drop-down 
menu and select the Print option. The Print 
window will appear on the screen.

Step 2 : Select the desired printer.

Step 3 : Click on the Print button.

Hence, your file will be printed.

3. To change wallpaper of your desktop, follow 
the given steps:

Step 1 : Open the picture that you want to use 
as a desktop background.

Step 2 : Right click on the picture. A list of 
options will be displayed.

Step 3 : Select Set as desktop background 
option from the list.

Hence, the desktop background of your 
computer will be changed.

4. To open the already saved file, follow the 
given steps :

Step 1 : Click the Open option in the Office 
Button drop-down menu. A window will 
display on the screen. This is Open window.

Step 2 : Select the file you want to open.

Step 3 : Click on the Open button.

Hence, your file will be displayed on the 
screen.
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Activity Time 5. Speakers, 6. Monitor, 7. Inkjet, 8. Projector.

Do yourself. 3. Operating System : Windows 7

Let’s Do SomethingComputer–3
A. 1. (b), 2. (c), 3. (c), 4. (b), 5. (c)

1. Computer System
B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (T)

Let’s Do Something
C. 1. Some elements of Windows are icons, taskbar, 

A. 1. (b), 2. (c), 3. (a), 4. (a), 5. (c) start button, etc.

B. 1. (b), 2. (d), 3. (e), 4. (f), 5. (c), 6. (a) 2. Operating system is a software program that 
provides an interface between hardware and C. 1. (T), 2. (F), 3. (T), 4. (T), 5. (F)
software components of computer system.D. 1. Computer is an electronic system that is made 

3. My Documents, Computer, Recycle Bin, of devices that help you enter data, process it, 
Network. store it and output the results.

4. To change the position of taskbar, follow these 2. CPU is called the brain of the computer.
steps :3. Central Processing Unit consists of three 

parts:–

• Arithmetic and Logic Unit

• Control Unit

• Memory Unit

4. ALU performs all the arithmetical  and logical 
operations in CPU.

5. Memory unit is used to store data.

Activity Time

Do yourself.

2. Hardware and Software
Activity Time

Let’s Do Something
Do yourself.

A. 1. (b), 2. (a), 3. (b), 4. (b), 5. (c)
4. NotepadB. 1. (c), 2. (a), 3. (f), 4. (b), 5. (d), 6. (e)

Let’s Do SomethingC. 1. (F), 2. (T), 3. (T), 4. (F), 5. (T)

A. 1. (c), 2. (a), 3. (b), 4. (c), 5. (a)D. 1. Hardware is the physical component of a 
computer. B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (F)

2. Software is the logical component of a C. 1. Notepad is a software program that allows you 
computer. to write on the computer.

3. Software are of two types– System software 2. To start Notepad application, select Start > All 
and Application software. Programs > Accessories > Notepad

4. Mouse, Keyboard, Printer, Monitor. 3. Maximize button

5. Two main components of a computer system 4. Elements of Notepad window are as under.
are hardware and software. •  Title Bar • Minimize Button  • Menu Bar

Activity Time •  Maximize Button  • Working Area
•  Close ButtonDo yourself

5. Scroll BarsB. 1. Output, 2. Plotter, 3. Input, 4. Printer,

Step 1 : Move the mouse pointer on the 
taskbar.

Step 2 : Click the right mouse button and 
select Properties option.

Step 3 : A window will appear on the screen. 
In window, click on the list in front of Taskbar 
location on screen and select the desired option 
say : Right.

Step 4 : Click on OK button.

Hence position of taskbar will be changed on 
the screen.
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Activity Time

Do yourself

5. Drawing in Paint

Let’s Do Something

A. 1. (b), 2. (c), 3. (a), 4. (c)

B. 1. (F), 2. (T), 3. (T), 4. (F), 5. (T)

C. 1. Line tool

2. To open an already saved drawing, follow the 
given steps :

Activity Time

Do yourself.

7. Introduction to LOGO

Let’s Do Something

A. 1. (b), 2. (a), 3. (c), 4. (b), 5. (c)

B. 1. (T), 2. (F), 3. (T), 4. (F), 5. (T)

C. 1. LOGO is a simple language used to draw 
figures, write text and do simple calculations.

2. MSW LOGO screen is divided into two 
sections :– • Main Screen • Commander 
Window.

3. The main screen is the area where pictures are 
drawn.

Activity Time 4. Command input box is used for typing the 
commands.A. 1. Rectangle tool, 2. Text tool, 3. Airbrush tool,

4. Polygon tool, 5. Fill with color tool. 5. To execute the commands in MSW LOGO, 
follow the given below :B. Do yourself.

6. Introduction to MS Word 2007

Let’s Do Something

A. 1. (c), 2. (b), 3. (b), 4. (b)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T)

C. 1. Vertical, 2. Cursor, 3. Exit Word, 4. Ribbon, Activity Time
5. Status

1. (e), 2. (a), 3. (b), 4. (c), 5. (d)
D. 

8. LOGO Primitives

Let’s Do Something

A. 1. (b), 2. (a), 3. (b), 4. (a), 5. (c)

B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (T)

4. The steps to save a document are :

Step 1 : Click on the Office Button and select 
Save option.

Step 2 : The Save As dialog box will be 
displayed.

Step 3 : Type the file name in the File name 
text box.

Step 4 : Click on the Save  button.

Hence, your file will be saved.

5. To close any document follow these steps :
Step 1 : Click on the Paint button and select 

Step 1 :  Click on the Office button.
Open option from the drop-down menu. An 

Step 2 : In the drop–down list, click on Close Open dialog box will appear.
option.

Step 2 : Select the File name that you want to 
open.

Step 3 : Click on Open button.

3. To save a drawing, follow the given steps :

Step 1 : Click on the Paint button. Select Save 
option from the drop-down menu.

Step 2 : The Save As dialog box appears.

Step 3 : Type the file name in the File name 
text box.

Step 4 : Click on Save button. The file will be 
saved.

4. Polygon tool is used for drawing different 
types of polygons.

5. Text tool is used to write text on paint screen.

Step 1 : Click in the Input box at the bottom of 
MSW LOGO commander.

Step 2 : Type the command, say, FD 100.

Step 3 : Press the Enter key to execute the 
command.

1. A word processor is a software that helps you 
to type text on a computer screen.

2. Quick access toolbar provides us with access to 
commands that we frequently use.

3. Save option is used to save a file in MS Word.
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C. 1. LOGO commands are known as primitives. 2. Uniform Resource Locator

2. FD command draws a line in the forward 3. Electronic-mail
direction for the given number of units. 4. Internet Service Provider

3. HOME command brings the turtle to the B. Do yourself.
starting position.

Computer–44. SETH command, followed by a number, turns 
the turtle towords the clockwise direction, no 

1. Evolution of Computers
matter which way the turtle head is pointing.

Let’s Do Something5. CLEAN command is used to erase the entire 
A. 1. (b), 2. (a), 3. (c), 4. (b), 5. (b)drawing from the screen but there is no change 

in the position of the turtle. B. 1. (F), 2. (T), 3. (T), 4. (F), 5. (F)

Activity Time C. 1.  (b),  2. (d), 3. (e), 4. (a), 5. (c)

A. 1. (ii), 2. (iv), 3. (i), 4. (vi), 5. (iii), 6. (v) D. 1. Early man used to do calculation on fingers 
and with the help of stones and pebbles.B. 1. Clear Screen, 2. Forward, 3. Backward,

4. Show Turtle, 5. Clear Text, 6. Hide Turtle. 2. Abacus was the first calculating device which 
is used for addition and subtraction of 9. Introducing Internet
numbers.

Let’s Do Something
3. Pascaline was the calculating machine which 

A. 1. (b), 2. (a), 3. (c), 4. (b), 5. (a) consisted of a box with eight moveable wheels. 
B. 1. (T), 2. (F), 3. (F), 4. (T), 5. (T) Using pascaline addition, subtraction, 

multiplication and division could be easily C. 1. Internet is a worldwide network of networks.
done.

2. Some of the uses of internet are as follows :
4. ENIAC stands Electronic Numerical Integrator 

and Calculator.

5. Characteristics of a computer are us under : –
• A computer can perform basic operations at a 
very high speed. • Computers are very 
accurate. • A computer has a very high storage 
capacity. • Computer can perform different 
types of jobs efficiently. • Computer does not 
suffer from lack of concentration.

Activity Time

1. 1616, 2 1642, 3 1890, 4 1946, 5 19th Century.

B. Do yourself

2. Memory and Storage

Let’s Do Something

A. 1. (b), 2. (a), 3. (c), 4. (a), 5. (b)

B. 1. (b), 2. (c), 3. (e), 4. (a), 5. (d)

C. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T)

D. 1. Memory is used to store data and instructions 
in CPU, Computer needs memory to store or 

Activity Time give output of any program.

A. 1. World Wide Web 2. Two types of memory are found in computer: 

? You can read your study material on the 
Internet.

? You can send and receive e-mail with the help 
of Internet.

? You can purchase a product through Internet.

? You can chat with people on the Internet.

? You can read news on Internet.

? You can get information on any topic through 
Internet.

3. A website is a collection of related web pages 
containing information related to a certain 
topic.

4. (a) There is no charge for sending and 
receiving email through internet. (b) Email is a 
quick method than the ordinary postage.

5. Websites and web pages are stored on powerful 
computers. These computers has very high 
capacity to keep information or data. These 
computers are known as web servers.
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Primary memory and Secondary memory.

3. Secondary storage devices are needed to store 
the data permanently.

4. (i) Hard Disk, (ii) Pen Drive, (iii) DVD.

5.

Activity Time

A. 1. Random Access Memory, 2. Read Only 
Memory, 3. Compact Disk, 4. Digital Versatile 
Disk, 5. Giya Byte

B. 1. Primary, 2. Brain, 3. RAM, 4. Permanent,
5. Bytes, 6. Giga Byte, 7. Bits, 8. ROM.

3. Microsoft Windows

Let’s Do Something

A. 1. (b), 2. (a), 3. (c), 4. (c), 5. (a)

B. 1. (T), 2. (T), 3. (T), 4. (T), 5. (F)

C. 1.

Step 2 : Choose the Copy option.

Step 3 : Move the mouse pointer where you 
want the file to be copied.

Step 4 : Right click anywhere on the screen.

Hard Disk is the main storage device of the 4. To rename a file, follow the given steps :
computer which is fitted inside the CPU box. Step 1 : Right click on the file to be renamed.
The hard disk consists of a set of magnetically 

Step 2 : Choose the Rename option.
coated disks placed one upon another and 

Step 3 :  The file name will turn blue and mounted together on a rotating hub. Each disk 
cursor will be displayed.in the set has its own read and write head. The 

heads on these devices never touch the surface Step 4 : Type the new name that you want to 
of the disk. give to the file.

Step 5 : Press the Enter key.

5. When a file or folder is useless, you want to 
delete it. To delete a file, follow these steps :

Step 1 : Right click on file to be deleted.

Step 2 : Click on Delete option.

Step 3 : Windows confirms before deleting the 
file by showing a dialog box.

Step 4 : Click on Yes button.

D. 1. A file is a collection of data stored in a storage 
device and a folder is a named memory space 
to keep files.To create a folder, follow the given steps :

2. To move a file, follow these steps :Step 1 : Click the right mouse button where 
Step 1 : Right click on the file, you want to you want to create a folder.
move.Step 2  : A submenu appears. Choose the New 
Step 2 : Choose the Cut option.option.

Step 3 : Move the mouse pointer where you Step 3 : Click the Folder option.
want the file to be moved.Step 4 : Type the folder name.
Step 4 : Right click anywhere on the new Step 5 : Press the Enter key.
location and click on Paste option.

2. To create a file, follow the given steps :
3. Notepad, Calculator, Paint and WordPad.

Step 1 : Go to the folder in which you want to 
4. To rename a file, follow the given steps :create a file.

Step 1 : Right click on the file to be renamed.Step 2 : Click on File menu.
Step 2 : Choose the Rename option.Step 3 : Choose New option. A list of options 
Step 3 :  The file name will turn blue and will appear on the screen.
cursor will be displayed.Step 4 : Click on Text Document.
Step 4 : Type the new name that you want to Step 5 : Specify the name of your file.
give to the file.

Step 6 : Press the Enter key.
Step 5 : Press the Enter key.

3. To copy a file, follow the given steps :
5. To open a file or folder, simply move the 

Step 1 : Right click on the file, you want to mouse pointer to the required file/folder and 
copy.
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double-click on it. The file/folder will open 
and you can view its contents.

Step 1 : Select the text that you want to copy.

Step 2 : Click on the Copy button in the Step 1 : Select the Free-form Selection tool in 
Clipboard group on the Home tab.the Image group.

Step 3 : Place the cursor at the location where Step 2 : To select the object, place the pointer 
you want to paste the text.on to Drawing area.

Step 4 : Click on the Paste button in the Step 3 : Press and hold down the left mouse 
Clipboard group on the Home tab.button and drag the pointer to select the part of 

the drawing. 4. The steps to select a paragraph in MS Word are 
:Step 4 : Release the mouse button after 

selecting the drawing. Step 1 : Place the cursor to the left of the first 
character to be selected.2. Flip/Rotate option is used to flip or rotate an 

object. Step 2 : Hold down the left mouse button and 
drag it to a position where you want to stop 3. To resize a picture horizontally, follow the 
selection.given steps :

Step 3 : Release the mouse button.Step 1 : Click on the Select tool and select the 
picture. Step 4 : The selected text gets highlighted.

Step 2 : Select the Resize option in the Image 
group on the Home tab. Resize and Skew 
dialog box appears on the screen.

Step 3 : In the Resize section type percentage 
or number of pixels in Horizontal text box.

Step 4 : Click on OK button.

4. The Skew option allows you to change one end 
of the drawing while the other end is fixed.

5. MS Paint has two selection tools. They are 
Select tool and Free-form Selection tool.

To change font type and font size, follow the 
given steps :

Step 1 : Select the text for which you want to 
change font type or font size.

5. Editing Text in MS Word 2007

Let’s Do Something
Activity Time

A. 1. (a), 2. (b), 3. (b), 4. (a), 5. (c)
A. Do yourself

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T)
B. 1. Rename, 2. File,  3. Two,  4. New,  5. Copy

C. 1. To make changes in your document, you have 
4. Advanced Features of Paint to first select the text in the document.

2. To delete a block of text in MS Word, follow Let’s Do Something
the given steps:A. 1. (a), 2. (a), 3. (a), 4. (a)
Step 1 : Select the block of text is to be B. 1. (F), 2. (T), 3. (T), 4. (T), 5. (F)
deleted.

C. 1. Select tool, 2. Free-form Selection tool,
Step 2 : Press the Delete key.3. Flip/Rotate, 4. Flip, 5. Resize

3. The steps for copying and pasting text are :D. 1. We can select a picture using Free-form 
Selection tool, by following these steps :

Activity Time

1. (b), 2. (d), 3. (e), 4. (a), 5. (c)

6. Formatting Text in MS Word 2007

Let’s Do Something

A. 1. (b), 2. (a), 3. (c), 4. (b), 5. (b), 6. (c), 7. (c)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F)

C. 1. Formatting is the general arrangement of text. 
It helps in changing the appearance of text by 
using various fonts, colours, sizes and styles.

Activity Time 2.

A. 1. (b), 2. (d), 3. (e), 4. (a), 5. (c)

B. Do yourself.
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Step 2 : To change the font size, click on Font 
Size drop-down arrow in the Font group and 
select any font size.

Step 3 : To change the font type, click on the 
drop-down arrow present next to the Font Style 
box and select the desired font from the 
displayed list.

3. Left align, Center align, Right align, Justify 
align.

4. Border and shading can be applied to the text 
by following steps :

Step 1 : Select the text.

Step 2 : Click on the drop-down arrow next to 
the Border button in the Paragraph group on 
the Home tab. Select Borders and Shading 
option. The Borders and Shading dialog box 
appears on the screen.

Step 3 : Under Setting section, click on Box 
option.

Step 4 : Under the Style section, select the line 
style.

Step 5 : Select the Colour and Width.

Step 6 : Click the drop-down arrow of Apply 
to section and select the Paragraph option.

Step 7 : Click on OK button and observe the Some rules which you must follow while 
change. naming the procedure name are :

5. To change the font colour, the steps are :
? The first character should always be a letter. 

Step 1 : Select the text that you wish to colour For example, Bag, A326, etc.
and click on Home tab. ? Blank spaces should not be used. For 
Step 2 : Click on the triangular drop-down example, ‘Red Square’ is an invalid name.
arrow next to the Font Color. button on the ? Arithmetic operators +, –, *, / cannot be 
Home tab. It will open a list of colours. used in the name. For example, ‘A*BC’ 
Step 3 : Select the desired colour from the name is invalid.
displayed colours. The colour of the text will ? Logo primitive’s names should not be used 
be changed. in procedure name. For example, ‘FD’ 

6. Alignment is the way of placing the text name is invalid.
between margins of a page. 3. To erase a procedure, select Erase option of the 

File menu in MSW LOGO window. A box will 
display on the screen. Click on the procedure 
name which you want to delete and click OK 
button.

4. To recall a saved procedure, LOAD command 
is used with the syntax LOAD ‘Procedure 
Name’.

C. 1. PRINT, 2. PR, 3. CT, 4. Quotient, 5. arithmetic

D. 1. PRINT “ARNAV

2. Four arithmetic operations are used in LOGO. 
They are : Additon (+), Subtracion (–), 
Multiplication (*) and Division (/).

3. To add more than two numbers using the sum 
operator, the numbers have to be written in 
round brackets like : PR (SUM 37 23 15)

4. Quotient function takes two inputs. It divides 
the first number by the second and given the 
quotient as the result.

5. Clear text command is used to clear the text 
screen.

Activity Time

A. Do yourself.

B. Do yourself.

8. LOGO Procedures

Let’s Do Something

A. 1. (b), 2. (b), 3. (c), 4. (a), 5. (c)

B. 1. (F), 2. (T), 3. (T), 4. (F), 5. (F)

C. 1. A procedure is a set of instructions written one 
after the other to perform a particular task and 
referred to by a name.

2.

Activity Time

1. (c), 2. (d), 3. (f), 4. (a), 5. (b), 6. (g), 7. (e)

7. Arithmetic Operations in LOGO

Let’s Do Something

A. 1. (c), 2. (c), 3. (a), 4. (b), 5. (a)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (F)

11
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into the computer is called input device. 
Keyboard and mouse are input device.

2. The device through which you see the output 
from the computer is called output device. 
Moniter and printer are most commonly used 
output device.

3. Computer follows the working of I–P–O cycle. 
I–P–O stands for Input – Process –  Output 
cycle.

4. A microphone is used to input sound into the 
computer while speakers are used to output 
sound from the computer.

5. CPU is the brain of the computer. All the 
processing and calculations of computer are 
performed by CPU. Without CPU a computer 
is useless.

Activity Time

A. 1. (b), 2. (f), 3. (e),  4. (b),  5. (a), 6. (d)

B. Do yourself.

3. Features of MS Word 2007

Let’s Do Something

A. 1. (c), 2. (a), 3. (b), 4. (a), 5. (b) Activity Time

B. 1. (T), 2. (F), 3. (T), 4. (T), 5. (F) A. 1. Find, 2. Proofing, 3. Ctrl+F, 4. Paragraph,
5.  Ctrl+BC. 1. Thesaurus are used to find synonyms for the 

words typed in the document. B.  Do yourself.

2. To change the text to lower case, follow the 4. Creating Tables in MS Word
given steps :

Let’s Do Something
Step 1 : Select the text for which you want to 

A. 1. (c), 2. (c), 3. (a), 4. (a), 5. (a), 6. (b)change case.
B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (T)Step 2 : Click on Change Case button in the 

Font group of Home tab. A list of options will C. 1. Table is the combination of rows and columns. 
appear on the screen. Tables are used to organize and manage data in 

tabular form.Step 3 : Select lowercase option.
2.3. (i) Sentence case, (ii) lower case, (iii) upper 

case, (iv) Capitalize each word, (v) Toggle 
case.

4.

Step 1 : Select Home tab. Click on the Find 
button in the Editing group. A menu appears on 
the screen.

Step 2 : Select the Find option in the menu. 
Find and Replace dialog box appears on the 
screen.

Step 3 : In the Find what box, enter the text 
that you want to search and press Enter key.

Step 4 : Click the Find Next button to find the 
next occurrence of the given text. If MS Word 
finds the text, it will highlight the text or word 
in the document.

Step 5 : Repeat step 4 until MS Word has 
finished searching the document.

Step 6 : When the search is finished, a 
Message box will appear. Click on OK button 
on the Message box.

Step 7 : Select the Highlight All option of 
Reading Highlight button. The given words 
will be highlighted in the entire text.

Step 8 : Close the Find and Replace dialog 
box.

The steps to create a table in a document are :

Step 1 : Place the cursor on the work area 
where you want to create a table.

The steps to add bullets to existing text are : Step 2 : Select the Insert tab. Click on the 
Table button in the Tables group.Step 1 : Select the text.
Step 3 : A menu will appear on the screen. Step 2 : Click on the Bullets button in the 
Select the Insert Table option. The Insert Table Paragraph group on the Home tab.
dialog box gets displayed.

Step 3 : Choose the style that you want to use 
Step 4 : Specify the number of rows and for the bullets in the list.
columns in the dialog box.

5. The steps to find text in a document are :

13



Step 5 : Click on OK button.

3. The steps to merge cells are : To insert a picture from file, follow the given 
steps :Step 1 : Select the cells you want to merge.
Step 1 : Place the cursor at the position where Step 2 : Click on Layout tab. Click on Merge 
you want to insert your picture.Cells button in the Merge group.
Step 2 : Click on Picture button in the 4. To steps to delete a column of a table are as 
Illustrations group on the Insert tab.under :
Step 3 : The Insert Picture window appears. Step 1 : Select the column you wish to delete.
Select the desired picture file.

Step 2 : Click on Delete button on Rows & 
Step 4 : Click on the Insert button.Columns group

5. Shapes is a drawing feature that helps you to Step 3 : Select Delete Columns option from 
draw different shapes like stars, banners, the menu.
callouts, connectors, etc.

Step 4 : Click on OK button.
6. To write text in a shape, follow the given steps 

5. Border is a black solid line around all the table 
:

cells. MS Word applies a 0.5 point black solid 
Step 1 : Place the cursor at the position where line border around all the table cells. Shading 
you want to write text in a shape.is the style of border.
Step 2 : Select a shape of your choice from the 
Shapes drop-down menu.

Step 3 : Drag the selected shape in the 
document according to your need.

Step 4 : Now right click on the drawing object 
and select the Add Text option from the 
shortcut menu.

Step 5 : Insertion point appears in the object. 
Now you can type the text in the document. 

To insert WordArt in a document, follow the 
given steps :

Step 1 : Select the Insert tab.

Step 2 : Click on WordArt button in the Text 
group. Choose a WordArt style from the given 
grid.

Step 3 : The Edit WordArt Text window 
appears with a selected placeholder text.

Step 4 : Choose the Font and Size of your text.

Step 5 : Type the text in the blank area and 
click on the OK button.

3. Word Art button is located on Insert tab.

4.

Activity Time

A. 1. Table, 2. Insert, 3. Insert Below,  4. Table,  5.  
Alt+O+B

B.  Do yourself.

5. Working with Objects in MS Word

Let’s Do Something

A. 1. (b), 2. (c), 3. (c), 4. (b), 5. (b)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (T)
Activity TimeC. 1. Clip Art is a gallery of pre–designed pictures 

Do yourself..that can be inserted into a document. Clip Art 
gallery consists of several categories of clips. 6. Customizing Windows

2. Word Art is a feature of MS word that allows 
Let’s Do Something

you to create some special effect and uniq u e  
A. 1. (a), 2. (b), 3. (a), 4. (b), 5. (c)look to the text.
B. 1. (F), 2. (T), 3. (F), 4. (T), 5. (T)

C. 1. Operating system is a software program that 
provides an interface between hardware and 
software components of computer system. 
Windows 7 is the latest version of windows 
operating system.

2. When you want to save your time in accessing 
commands or accessing any program, you use 
shortcut menu also known as context menu.

3. The steps of creating shortcut of Notepad 
program are :

Step 1 : Move on Start > All Programs > 
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Accessories > Notepad

Step 2 : Right click on the Notepad option.

Step 3 : A pop–up menu with a list of options 
appears on the screen.

Step 4 : Select Send to option, another 
cascading menu appears on the screen.

Step 5 : Now click on Desktop (create  
shortcut) option.

Step 6 : Click on any blank space on desktop 
or press Esc button.

4. The right pane consists of the following items :

Current user, Documents, Pictures, Music, 
Activity TimeGames, Computer, Control Panel, etc.

1. (e), 2. (c), 3. (d),  4. (a),  5. (b)Activity Time

8. MS PowerPoint : Working With Text Do yourself.

Let’s Do Something7. Introducing MS PowerPoint 2007
A. 1. (b), 2. (a), 3. (a), 4. (c), 5. (b), 6. (b)Let’s Do Something
B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T)A. 1. (b), 2. (a), 3. (b), 4. (c), 5. (c), 6. (b)
C. 1.B. 1. (F), 2. (T), 3. (T), 4. (F), 5. (T)

C. 1. Slides are the individual pages of a MS 
PowerPoint presentation.

2.

below :

Step 1 : Click on the Close option of Office 
button drop-down menu.

Step 2 : If the file has not been saved, MS 
PowerPoint will display a dialog box asking 
you to save the changes you have made.

• Click Yes if you want to save the changes 
done in the presentation.

• Click No if you don’t want to save the 
changes done in the presentation.

• Click Cancel if you want to return to the 
presentation.

To place text anywhere on a slide, you first 
need to add a new text box.

The steps to add a new text box on the slide 
are:

To start Microsoft PowerPoint, follow the steps 
Step 1 : Select Insert tab.given below:
Step 2 : Click on Text Box button on the Text Step 1 : Click on Start button.
group.

Step 2 : Select All Programs option.
Step 3 : Move the cursor to the place on the 

Step 3 : Point on Microsoft Office. A sub-
slide where you want  to add the text box.

menu appears.
Step 4 : Hold down the left mouse button. 

Step 4 : Now click on Microsoft Office 
Drag the mouse down and to the right to draw 

PowerPoint 2007. The Microsoft PowerPoint 
the text box.

window appears.
Step 5 : Release the mouse button, when the 

3. PowerPoint is a presentation software It is used 
text box is of desired size.

to create professional presentations.
2. (i) Sentence case, (ii) lower case, (iii) upper 

4. To save a presentation, follow the steps given 
case, (iv) capitalize each word, (v) toggle case.

below :
3. Mouse pointer takes the   shape.

Step 1 : Select Save option of Office button 
4. If you want bulleted list in your slide then drop-down menu.

follow these steps:
Step 2 : The Save As dialog box appears on 

Step 1 : Select Home tab.the screen.
Step 2 : Click on Bullets button drop-down Step 3 : Type the file name in the File name 
menu in the Paragraph group.text box.
Step 3 : A list of options will appear on Step 4 : Click on Save button.
clicking the drop-down menu. Select Bullets 

5. To close a presentation, follow the steps given 
15



and Numbering option. of static images or pictures.

Step 4 : Bullets and Numbering dialog box Animation : It is the series of moving pictures 
will appear on the screen. Select an appropriate with slightly different movement so as to 
layout of bullets or numbering that you want create an illusion of movement.
and click on OK button.

5. The steps to delete text from a slide are :

Step 1 : Select the text that you wish to delete.

Step 2 : Press Delete key on the keyboard.

Hence, selected text will be deleted from the 
slide.

Different components of a multimedia file are :

Text : It is the textual data in the form of 
alphabets,  numbers and symbols.

Primary Memory : This memory is also 
Sound : It is the data in the form of voice and 

known as Main Memory. Primary memory is 
speech.

used as a form of temporary memory for 
Picture : It is the data in the form of images calculation processes and storage of temporary 
like graphics and clip arts. values that need rapid access or updating. The 

contents of the primary memory disappear Photographs : These are actual still pictures.
when the power is turned off. Primary memory Video : These are actually moving pictures or 
is important while executing programs. Bigger images.
programs require more primary memory.

Graphics : It is the creation and manipulation 

Activity Time

1. Video, 2. Sound, 3. Photographs, 4. Animation, 
5. Text.

10. Algorithm and Flowchart

Let’s Do Something

A. 1. (T), 2. (T), 3. (F), 4. (T), 5. (T)
Activity Time

B. 1. Algorithm is a set of instructions that uses a 
1. F7, 2. Proofing, 3. Home, 4. Toggle case, 5. step by step description of the procedure.
New slide button.

2. A flowchart is a representation of a 
9. Multimedia problem–solving process, in which steps are 

laid out in a logical order.Let’s Do Something
3. Decision box is used when one needs to choose A. 1. (c), 2. (a), 3. (c), 4. (b), 5. (c)

between options and the condition of Yes/No 
B. 1. (F), 2. (F), 3. (F), 4. (T), 5. (T)

arises.
C. 1. (d), 2. (c), 3. (a), 4. (b)

4. Process box is used for writing processes or 
D. 1. Multimedia is an application that combines and actions for example, multiplying two numbers.

executes text, sound, video, animation and 
5. Flow lines are used to show the flow of logic 

graphics simultaneously.
in a flowchart.

2. Windows Media Player is a multimedia 
Activity Time

application. It is used to listen to an audio or a 
Do yourself.video CD on the computer.

3. To start Windows media player, follow the Computer–6
given steps :

1. Computer PeripheralsStep 1 : Click on the Start button.

Let’s Do SomethingStep 2 : Select All Programs.

A. 1. (a), 2. (c), 3. (b), 4. (d), 5. (d)Step 3 : Click on Windows Media Player.

B. 1. (F), 2. (F), 3. (T), 4. (T), 5. (F)4. Education, Advertising, Playing games and 
Creating presentation. C. 1. The input and output devices attached to a 

computer are called computer peripherals. 2. 5.
Memory is of two types : (i) Primary Memory 
(ii) Secondary Memory 
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Secondary Memory : This memory is also 
called auxiliary memory or back-up memory. 
Secondary memory is used for the storage of 
most of the system’s data, programs and all 
other permanent data that should stay there 
even when the power is turned off. As a To change the paper size, follow the given 
computer is fed with bigger, smarter programs steps :
and more data, it would naturally need more 

Step 1 : Select the Page Layout tab. Click the 
secondary memory to hold them.

Margins button in the Page Setup group. A 
3. (i) Random Access Memory (RAM) drop-down list of options appears.

• The CPU uses this memory while Step 2 : Select the Custom Margins option. 
processing information. The Page Setup dialog box will appear.

• This is also called read/write memory. Step 3 : Select the Paper tab in the Page Setup 
• This memory is temporary in nature. dialog box.

(ii) Read Only Memory (ROM) Step 4 : Select a predefined paper size from 
the Paper size drop-down list. or You can also • ROM contains a basic set of instructions 
specify the width and height of your paper in called the Basic Input-Output System 
which the page is being printed in Width and which helps to start the operating system.
Height boxes.

• It is a memory unit that can only be read 
Step 5 : Click on OK button to apply the from.
selected new settings to your document.

• It is a permanent memory.
2. Paragraph alignment means the way of placing 

4. A computer has a very large internal memory. 
the paragraph between the margins of a page.

It can store a vast amount of information and 
3. To print a document, follow the given steps :can recall that information instantly and 

correctly whenever desired. The memory of a Step 1 : Click on the Office Button and move 
computer can be classified into primary mouse on the Print option.
memory and secondary memory. Step 2 : Click on the Print option. The Print 

dialog box opens.

Step 3 : In the Printer section, you can select 
the printer to be used for printing, in the Name 
drop-down list.

Step 4 : Page range section allows you to 
choose the pages to be printed. You can print 
all pages of the document, current page or you 
can specify the range of pages, e.g., 6–12, for 5. Output devices are used to get result or 
consecutive pages and specify individual pages information from the computer system. These 
using comma ‘,’ operation in the Pages box.devices convey information from the computer 

to the user. Two commonly used output Step 5 :  In the Copies section, specify how 
devices are monitor and printer. many printouts you want to take of your 

document.6. A light pen is a pointing device shaped like a 
pen and is connected to a monitor. A light pen Step 6 : Press OK button to get the printouts of 
consists of a photocell mounted on a   pen- your document.
shaped tube and is capable of sensing a 

4. Header is the text that is printed at the top of 
position on the screen when its tip touches the 

each page in the document, whereas footer is 
screen.

the text printed at the bottom of the page in the 

2. Advance Features of MS Word

Let’s Do Something

A. 1. (b), 2. (c), 3. (c), 4. (d), 5. (a)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F)

C. 1.
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document. To insert SmartArt in your presentation, follow 
the given steps :5. Performing a mail merge, involves three basic 

steps : Step 1 : Select a slide from your presentation 
where the SmartArt has to be inserted.1. Creating the main document : This 

contains the standardized text that will be Step 2 : Click on SmartArt button in the 
printed on all the merged documents. The main Illustrations group on Insert tab.
document has a merge field. This is a place Step 3 : Choose a SmartArt Graphic dialog 
holder which instructs where and what will be box appears on the screen. Select a type of 
inserted from the data source. SmartArt from the available list.
2.  Creating the data source : This is a file Step 4 : Click on OK button after selecting 
which contains the variable data that is to be suitable SmartArt.
inserted in the document. In the above case, the 

Step 5 : SmartArt will be inserted on the slide. 
addresses of all the persons to whom letters 

Now you can add text inside the SmartArt 
have to be sent, will form the variable data that 

diagram according to your requirements.
is stored in the data source.

4. To change theme of your presentation, follow 
3.  Merging the data source and the main 

the given steps:
document.

Step 1 : Select Design tab.
6. Creating a Recipient list involves three steps :

Step 2 : Scroll the mouse over the available 
Step 1 : Click the option Type a new list under 

themes and select the desired theme under 
Select recipients and then click at Create to get 

Themes group. The selected theme will be 
a New Address List dialog box.

applied in your presentation.
Here, type the details of the first recipient. You 

Step 3 : For more themes, click on the More 
can leave the fields blank, if not required. After 

drop-down arrow at the bottom right corner of 
typing the details of first entry, click at New 

Themes group.
Entry button to get the next blank form. After 

Step 4 : A drop-down menu will appear. In the typing all the entries, click on Close button. 
drop-down menu, you can select theme of your Save Address List dialog box appears. Type the 
choice.desired name and click on Save button.

5. To create a presentation using built-in template, Step 2 : Mail Merge Recipients window 
follow the given steps :appears which shows the data you have 

entered. You can edit the data you want. Step 1 : To start MS PowerPoint, select Start > 
All Programs > Microsoft Office > Microsoft Step 3 : Click on OK button.
Office PowerPoint 2007.

Step 2 : Click on New option of the Office 
Button drop-down menu. The New 
Presentation dialog box will appear.

Step 3 : Click on Installed Templates option 
under Templates section.

Step 4 : Select a template of your choice from 
the Installed Templates section and click on 
Create button.

Step 5 : The selected template opens as a new 
presentation. The new presentation contains 
various slides, illustrating different slide layout, 
backgrounds, themes, etc.

3.

3. MS PowerPoint Presentation

Let’s Do Something

A. 1. (c), 2. (b), 3. (c), 4. (c), 5. (b)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (F)

C. 1. A slide is the individual page of the 
presentation to which you can add text, 
colours, pictures and sound.

2. MS PowerPoint is the most commonly used 
software for creating presentations. It is widely 
used in offices for creating business 
presentations. It is one of the members of 
microsoft office family and also in schools for 
creating presentations on different topics.
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6. Templates are the sets of pre–designed formats requirements and observe the changes in your 
that include text, layouts, colour schemes, slide.
pictures, sound etc. that help in creating a 6. To apply texture to the background, follow the 
beautiful presentation. given steps :

Step 1 : Click on Background Styles button, 
present in the Background group on Design 
tab. A list of options will be displayed.

Step 2 : Click on Format Background option. 
The Format Background dialog box will 
appear on the screen.

Step 3 : Click the required radio button, say, 
Picture or texture fill.

Step 4 : Select the various options according to 
To apply colour scheme to the slide, follow the your choice and click on Apply to All button.
given steps :

Step 5 : Close the Format Background dialog 
Step 1 : Open your presentation and choose the box.
slide whose colour scheme you want to 
change.

Step 2 : Move the mouse over a theme in the 
Themes group on Design tab.

Step 3 :  Select the desired theme. The theme 
will be applied to all the slides.

Step 4 : Click on Colors button in the Themes Clip Art is used to add pictures in the slides. 
group and select the colour scheme of your You can add Clip Art images to the existing 
choice. slide and enhance its appearance.

Step 5 : To apply the colour scheme to : To insert Clip Art in your presentation, follow 
the given steps :• all the slides, right-click on the 

colour scheme and select the Apply Step 1 : Open the slide and place the cursor on 
to All Slides option. which you want to insert the Clip Art image.

• the selected slide, right-click and Step 2 : Click on the Clip Art button in the 
select the Apply to Selected Slides Illustrations group on Insert tab.
option.

Step 3 : Clip Art task pane will appear on the 
right side of the window.

Step 4 : In the Search for text box, type the 
word or phrase of the picture you want to insert 

To change slide layout, follow the given steps : and click on Go button.

Step 1 : Choose the slide whose layout you Step 5 : It will display the list of Clip Art 
want to change in your presentation. images related to your typed word or phrase.

Step 2 : Click on Layout button in the Slides Step 6 : Click on the desired Clip Art to insert 
group on the Home tab. it in the slide.

Step 3 : A drop-down list appears on the screen 2. To insert WordArt on the slide, follow the 
called the Layout drop-down list with various given steps :
layouts.

Step 1 : Click the WordArt button in the Text 
Step 4 : Select the layout according to your group on Insert tab.

4. Working With Slides in PowerPoint

Let’s Do Something

A. 1. (a), 2. (b), 3. (d), 4. (a), 5. (c)

B. 1. (T), 2. (F), 3. (T), 4. (F), 5. (F)

C. 1. Normal view is divided into three panes – 
Outline pane, Slide pane and Notes pane.

2. Notes pane is used to add the information you 
want to share with the audience.

3. 

5. Adding Graphics and Objects in MS 
PowerPoint

Let’s Do Something

A. 1. (d), 2. (c), 3. (b), 4. (d), 5. (d)

B. 1. (F), 2. (T), 3. (F), 4. (T), 5. (F), 6. (T)

C. 1.

4. Each slide has its own layout, called slide 
layout, Layout refers to the way, the things are 
organized on a slide.

5.
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+

Step 2 : WordArt gallery drop-down menu options will appear on the screen. Click on Edit 
appears on the screen. Click on the required Text option.
WordArt style. Step 3 : Cursor will appear on the middle of 
Step 3 : A placeholder appears on the screen shape. Now write the text on the shape.
with sample text ‘Your Text Here’. In the Hence, you can write text on your desired 
placeholder, type something say ‘Signature shape.
Books International’.

5. To insert a table in a presentation, follow the 
Step 4 : Select the typed text and click on Text given steps :
Fill drop-down arrow in WordArt Styles group 

Step 1 : Open the slide on which you want to 
on the Format tab. Select the desired colour for 

insert a table.
your text and observe the change.

Step 2 : Click on Table button in the Tables 
Step 5 : Click on Text Outline drop-down 

group on Insert tab. A list of options appears on 
arrow. Choose the desired outline colour from 

the screen.
the displayed list.

Step 3 : Select the Insert Table option. The 
Step 6 : Click on Text Effects drop-down 

Insert Table dialog box gets displayed on the 
arrow and click on the desired effect you want 

screen.
to give to your text.

Step 4 : Specify the number of rows and 
3. Shapes is a drawing feature that helps to draw 

columns in the dialog box and click on OK 
different shapes like Stars, Banners, 

button.
Flowcharts, Callouts, etc.

6. A chart is a graphical presentation of data. It is 
To insert shapes on the slide, follow the given 

an effective way to display data in pictorial 
steps :

form. Charts make it easier to show 
Step 1 : Open the slide on which you want to comparison, growth and relationship among 
insert shape object. the values in data.
Step 2 : Click on Shapes button in Illustrations 7. To create a chart in PowerPoint, follow the 
group on the Insert tab. given steps :
Step 3 : Shapes drop-down menu appears on Step 1 : Open the slide on which you want to 
the screen with various shapes like Lines, create a chart.
Rectangles, Block Arrows, Callouts, etc.

Step 2 : Click on Chart button in the 
Step 4 : Select the category and from the Illustrations group on Insert tab.
different shapes of that category, click one that 

Step 3 : Insert Chart dialog box gets displayed. 
you want to draw.

Select the chart of your choice and click on OK 
Step 5 : Bring the mouse pointer on the slide button.
and drag diagonally to draw the shape of 

Step 4 : The chart will be displayed with a 
desired size.

datasheet that contains the default data. You  
Step 6 : To resize a shape, select the shape by can enter your own data in the datasheet. To 
clicking on it. It displays eight handles on the delete all the data from the datasheet, move the 
object. Place the mouse pointer on any handle. mouse pointer to Blank button.
The pointer changes to double-headed arrow. 

Step 5 : The mouse pointer changes into a 
Drag the handle to increase or decrease the size 

large plus sign ‘+’ of white colour. Click on the 
of shape.

button and press the Delete key to delete the 
4. To write text in a shape, follow the given steps: data.

Step 1 : Select the shape on which you want to Step 6 : Type the table in the worksheet whose 
write text. data you want to see in chart form.
Step 2 : Right-click on the shape. A list of 
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Step 7 : As you enter the data, the chart gets desktop, maximize or minimize it just by 
plotted automatically. moving it.

Step 8 : To close the datasheet, click on the Aero Peek
Close button on the Title bar. This feature helps you to view the desktop 

without minimizing or closing programs. After 
viewing, you can instantly bring the program 
windows back to their original positions. This 
is accomplished through a ‘Show Desktop’ 
button that appears at the right-most end of the 
task bar.Microsoft is well-known for continuously 

6. Jump list provides quick way to find the improving the various features of Windows, 
opened or recently opened files. Do you and this has lead to many versions of it. After 
remember the ‘Recent Documents’ in the the arrival of many versions of Windows 1, 2 
previous version of Windows? Yes, jump list and 3, the company brought out Windows 95 
resembles the same feature. However, jump and Windows 98. Windows ME (Millenium 
lists are grouped by the program to which the Edition) was released after Windows 98, which 
file belongs. This allows you to open files from adopted the features of both the Windows 98 
the same taskbar button that you use to open and Windows 2000. Windows XP and 
the program.Windows Vista were later developed in this 

series. The most recent version is called the 7. To display two application windows at the 
Windows 7. same time, follow the given steps :

2. Windows 7 has its six different editions. These Step 1 : Open MS PowerPoint and MS Excel 
are : programs one by one. The PowerPoint window 

is active as present.• Windows 7 Starter

Step 2 : Now, right-click anywhere on the • Windows 7 Home Basic
blank portion of the taskbar.• Windows 7 Home Premium
Step 3 : A list of options will appear on the • Windows 7 Professional
screen.

• Windows 7 Enterprise
Step 4 : Click on Show Windows side by side 

• Windows 7 Ultimate
option from the shortcut menu. Both the 

3. Aero Shake, Aero Snap, Aero Peek, Sticky application windows will be displayed side by 
Notes. side.

4. Pinning allows easy tracking and opening of an 
application. Any application can be pinned to 
the task bar by dragging and dropping it on to 
task bar. You can also right-click on the 
shortcut of an application in the Start menu and 
select the option ‘Pin in the taskbar’.

Microsoft Excel is an electronic spreadsheet. It 
To remove the pinned application from task is an application software that helps in 
bar, just right click on the specified pinned calculation using formulae and analysis of data 
icon on the task bar and click ‘Unpin this using tables. It allows you to arrange data into 
program from taskbar’. rows and columns. It also facilitates speedy 

and accurate mathematical calculations.5. Aero Snap

2. Three types of data can be entered in an MS Snap enables you to control the window size 
Excel worksheet :  • Number     • Textand location on your desktop. You can move a 
•  Formulaeprogram window to the left or right of the 

6. Windows 7

Let’s Do Something

A. 1.  (b), 2. (d), 3. (a), 4. (c), 5. (d)

B. 1. (T), 2. (F), 3. (F), 4. (F), 5. (T)

C. 1.

7. MS Excel 2007

Let’s Do Something

A. 1. (c), 2. (a), 3. (d), 4. (b), 5. (c), 6. (b)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (T), 6. (F)

C. 1.
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Number After you have entered data into a cell, you can 
make changes in it. There are two ways in Number data is formed with numeric digits 
which you can edit the cells data : (i) By 0–9 and is used for the calculations. By default 
overwriting cell contents  (ii) By modifying numbers are right aligned in a cell.
cell contents partially

Text
2. Row height is automatically adjusted in MS 

Text data consists of alphabets, combination of 
Excel if you enter taller characters. But, to 

alphabets, and numbers which cannot be used 
manually change the height of a single row, 

for the calculation. Text data is always left 
click on the bottom border of the row–heading 

aligned in the cell.
and drag it up or down.

Formulae
To change the height of several rows at once, 

Formulae consists of mathematical operators follow the given steps :
and cell address. You can enter formulae which 

Step 1 : Select the required rows for which you 
will give ‘answer’ after calculation, that is a 

want to change height.
number. It always start with a ‘=’ sign. 

Step 2 : Click on Format button in the Cells Example, ‘= A1 + B1’.
group. A menu appears. Select Row Height 

3. There are 65536 rows and 256 columns in an 
option.

Excel worksheet.
Step 3 : A dialog box appears called Row 

4. Workbook is the collection of worksheets. 
Height dialog box.

Initially there are only three worksheets in a 
Step 4 : Enter the new height of the current workbook but you can insert as many as you 
rows and click on OK button.want.

3. To change the width of several columns at 5. A cell is the smallest unit of a worksheet, 
once, follow the given steps :formed by the intersection of a row and a 

column. Each cell has a unique address formed Step 1 : Select the required columns for which 
by the combination of a column letter and a you want to change width.
row number. Step 2 : Click on Format button in the Cells 

6. To edit data, perform the following steps : group. A menu appears. Select Column Width 
option.Step 1 : Select the cell that you wish to edit.
Step 3 : A dialog box appears called Column Step 2 : Double click on it or press F2 key. 
Width dialog box.Either way, the cursor is positioned at the end 

of the content of the cell. Use the Backspace Step 4 : Enter the new column width in the 
key to remove one character at a time. Column width text box and click on OK 

button.Step 3 : However, to remove the entire content 
of a cell, start typing the new content by 4. When you need to add a row or column in a 
selecting the cell. The old content is replaced worksheet which is already created, follow the 
by the new one. given steps :

7. The cell having a dark border, is called the Step 1 : Select the row immediately below the 
active cell. You work in one ‘active cell’ at a point where you want to insert a new row. To 
time. The border around the active cell is insert a new column, select the column to the 
called the cell pointer. right of the point of insertion. You can select 

the entire row by clicking on the row header or 
the column header to select the entire column.

Step 2 : Click on Insert button drop-down 
menu in the Cells group on Home tab.

Step 3 : A submenu appears on the screen. 

C. 1.

8. Editing Cell Contents in MS Excel

Let’s Do Something

A. 1. (c), 2. (d), 3. (a), 4. (b), 5. (d), 6. (d)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (F)
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Click on Insert Sheet Rows option to insert a receiving e-mail messages even though the 
new row and Insert Sheet Columns option to message travels across the world.
insert a new column. Content : You can attach photos, videos or 

5. The Undo command allows you to reverse that important data along with  your message. The 
last action you have performed. Redo message may consists of only a few lines of 
command is used to quickly repeat the last text to thousands of lines.
action that you have done using Undo Reliability : E-mail is the reliable mode of 
command. communication. It is more reliable than 

6. MS Excel’s Autofill feature lets you enter a ordinary postage.
predefined series of data such as text or  4. To send an e-mail, follow the given steps :
numbers quickly in a worksheet. It can be 

Step 1 : Open any e-mail website, say 
applied in a worksheet by using following 

www.gmail.com and enter your e-mail address 
procedure.

and password.
Step 1 : Enter the first two values of the data in 

Step 2 : The next screen will be you Inbox. 
adjacent cells. The first two data values 

Now click the option ‘Compose’ on the left 
determine the increment value and the starting 

side of the account screen. A message screen 
number for the series.

will appear.
Step 2 : Select the two cells.

Step 3 : In the To box, type the e-mail address 
Step 3 : Click the AutoFill handle (a small of the person to whom you want to send mail. 
black square) in the lower right corner of the Write your message in the large empty box.
selected cells and drag it down to enclose the 

Step 4 : Click on Send button.
area you want to fill with the number series.

5. (a) www.yahoomail.com
Step 4 : Release the mouse button. The cells 

(b) www.gmail.comenclosed in the gray border will be filled with 
the desired number series. (c) www.rediffmail.com

D. 1. Ctrl + Z, 2. Ctrl + Y, 3. Ctrl + C, 4. Ctrl + V, 5. 6. URL (Uniform Resource Locator) : Uniform 
Ctrl + A Resource Locator is the address or location of 

a website on the Internet. To visit a website, 
type the URL of the website in the address bar 
and then press the Enter key. URL of some 
websites are :

• http://www.ncert.nic.in   • 
http://www.discovery.com

• http://www.google.com

Web Page : The individual pages which 
collectively form the World Wide Web are 
known as Web Pages. These pages contain text, 
graphics, audio, video and links to other pages.

These pages may contain text, often underlined 
The advantages of using an e-mail program are and coloured, or a small image, called an icon.
the following :

Speed : E-mail is far quicker than ordinary 
postage. A message can reach any part of the 
world in a fraction of a second.

Cost : Nothing is charged for sending and 

9. Exploring Internet

Let’s Do Something

A. 1. (c), 2. (b), 3. (c), 4. (d), 5. (b)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (T)

C. 1. Internet is a global network of computers, used 
for sharing information.

2. E-mail is an electronic mail sent from one 
computer to another. It is the most widely used 
application. It is a facility on internet to 
compose, store, send and receive messages to 
any part of the world.

3.

10. Introduction to QBasic

Let’s Do Something

A. 1. (b), 2. (a), 3. (d), 4. (c), 5. (a)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (F)
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C. 1. Computer–7
1. Advancement in Computer Technology

Let’s Do Something

A. 1. (b), 2. (d), 3. (b), 4. (c), 5. (a)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F), 6. (T)

C. 1.

QBASIC is the simplest, interactive high-level 
programming language. It was developed in 
Dartmouth College, USA, under the direction 
of Professors John G. Kemeny and Thomas E. 
Kurtz, in 1964. Though it was developed as a 
beginner’s language, it has become very 
popular due to its simplicity.

Robotics is the branch of engineering involved 2. Numeric Data : Numeric values on which 
in the development and creation of machines mathematical operations such as addition, 
capable of doing a given task automatically subtraction, multiplication, division, etc. can be 
without any human intervention, once it has performed are called numeric data.
been programmed.String Data : The data that do not perform any 

2. It is the study and design of an intelligent mathematical operation except additon (+) but 
system that understands the environment can be used for comparison are called string 
around it and takes action accordingly. AI aims data.
at simulating a machine like a human brain. 3. Logical operators are used to combine two or 
Today, this is the most essential part of the more relational expressions to produce a single 
technology industry, which provides solutions value which can be either true or false. NOT, 
for the most difficult problems in computer AND, OR are the logical operators.
science.

4. Arithemtic Operators : An arithmetic 
3. A rocket launching is the first phase of the operator works on numeric constants and 

flight of a rocket. For launching into variables and always gives a numeric output.
interplanetary space, rockets are launched from 

Relational Operators : A relational operator is 
a launch pad, which is usually a fixed location 

used to compare the values of two or more 
on the ground. Computers are used at the 

constants or variables.
design stage of the project and in all phases of 

5. To save a program in QBASIC, follow the development right through to the flight control 
given steps : of the rocket.

Step 1 : Select Save option from File menu. 4. On today’s generation ATMs, the customer is 
recognised by inserting a plastic ATM card Step 2 : The Save dialog box appears. Select 
with a magnetic stripe or a plastic smart card the required drive and directory.
with a chip that contains a unique card number Step 3 : Type the file name. An extension .BAS 
and some security information. Nowadays by will be automatically generated.
using an ATM, customers can access their bank 

Step 4 : Click on OK button. accounts in order to make cash withdrawals 
6. To open already saved program in QBASIC, and check their account balances as well as 

follow the given steps : purchasing other things.

Step 1 : Select Open option from the File 5. Networking management and administration of 
menu. entire system of banking can be done only 

because of IT. ATMs are used to manage and Step 2 : The Open dialog box appears. This 
process information of the customers which is dialog box shows a list of all the BASIC files 
done because of IT. So, IT is useful in banks.of the current directory. Select the required 

drive, directory and file. 6. An optical computer is a computer that uses 
light instead of electricity (i.e. photons) to Step 3 : Click on OK option.
manipulate, store and transmit data. Because of 
the fundamental different physical properties 
of photons, the basic principle used in optical 
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computer is optics, to produce computer with system has only two digits (0,1) and the 
performance and capabilities greater than those addition table is given below :
of electronic computers. Optical computer 0 + 0 = 0
technology is still in the early stage.

0 + 1 = 1
To replace electronic components with optical 

1 + 0 = 1
ones, an equivalent ‘optical transistor’ is 

1 + 1 = 0 and carry over 1required. This is achieved using materials with 
a non-linear refractive index. Example :   Add (1000)  and (101)2 2

1 0 0 0

+  1 0 1

 1 1 0 1 =  (1101)2 

(1000)  + (101) =  (1101)2 2 2 

5. To convert the decimal number  to a binary 
number, follow the steps given below :

D. 1. All through your primary schooling, your Step 1 : Divide the decimal number by 2.
teachers must have made you count from 1 to 

Step 2 : Proceed the division with divisor till 
100, then 101 to 200 and so on. But, your 

you get 0 as dividend.
counting must have followed a set pattern. All 

Step 3 : Collect all the remainders, i.e. from that you had to do was to learn 10 new 
the first remainder (LSB– Least Significant symbols, that is 0, 1, 2, 3, 4, 5, 6, 7, 8, 9. 
Bit) to the last remainder (MSB—Most Beyond 9, all the numbers were generated by 
Significant Bit) and put them together to get using these 10 symbols in various 
the binary equivalent.combination. The system of representing 
Step 4 : Arrange all the binary digits from numbers that is used the world over is known 
MSB to LSB.as the decimal number system. Thus, number 

system is the method of counting. 6. Octal Number System : Number system made 
2. up of eight symbols,  0 to 7, is known as the Number system made up of only two symbols, 

Octal Number System.0 and 1, is known as the Binary Number 
System. When this system is in use, every number is 

formed using 0, 1, 2, 3, 4, 5, 6 and 7. Since When this system is in use, every number is 
formation of numbers involves the use of these formed using 0 and 1. Since formation of 
eight symbols, the base of the octal number numbers involves the use of these two 
system is said to be 8. The symbols 0 to 7 are symbols, the base of the binary number system 
known as octal digits.is said to be 2. The symbols 0 and 1 are known 

as binary digits or bits in short. E. 1. (a) 2 39 (b) 2 79
3. Number system made up of ten symbols, 0 to 2 19 1 2 39 1

9, is known as Decimal Number System.
2 9 1 2 19 1

When this system is in use, every number is 
2 4 1 2 9 1

formed using 0, 1, 2, 3, 4, 5, 6, 7, 8 and 9. 
2 2 0 2 4 1Since formation of numbers involves the use of 

these ten symbols, the base of decimal number 1 0 2 2 0
system is said to be 10. The symbols 0 to 9 are 1 0
known as decimal digits.

(39)   =  (10011) (79) =  (1001111)10 2 10 24. Binary addition is performed in the same 
manner as decimal addition. Binary number 

2. Number System

Let’s Do Something

A. 1. (c), 2. (a), 3. (c), 4. (b), 5. (d)

B. 1. A, B, C, D, E, F; 2. divide; 3. 0 to 9; 4. 16; 5. 0 
and carry over 1.

C. 1. (T), 2. (F), 3. (T), 4. (F), 5. (F)

+ 

0

+
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(c) 2 143 (d) 2 49

2 71 1 2 24 1

2 35 1 2 12 0

2 17 1 2 6 0

2 8 1 2 3 0

2 4 0 2 1 1

2 2 0
To add sound or music file in a slide, follow 1 0
the given steps:

(143)   =  (10001111) (49)   =  (110001)10 2 10 2 Step 1 : Open or navigate the slide on which 
you want to insert sound file.2. (a) (1100)2

3 2 1 0 Step 2 : Select the Insert tab.2 2 2 2

Step 3 : Click the drop-down arrow on the 8 4 2 1
Sound button in the Media Clips group. A pop-

1 1 0 0
up menu appears on the screen.

8 + 4 + 0 + 0 = 12
Step 4 : Select the Sound from File option 

(1100)   =  (12) from the pop-up menu.2 10

Step 5 : The Insert Sound dialog box will (b) (10001)2

appear on the screen.
1 0 0 0 1

Step 6 : Locate the sound file on your 
16 8 4 2 1

computer and click on Open button.
16 + 0 +0 + 0 + 1  =  17

Step 7 : Another dialog box named Microsoft 
Office PowerPoint will appear on the screen (10001)   =  (17)2 10

displaying the message : ‘How do you want the 
(c) (11111)2 sound to start in the slide show?’

16 8 4 2 1
Step 8 : Here, you can either click on 

1 1 1 1 1 Automatically or When Clicked button. 
Automatically option will start the sound 16 + 8 + 4 + 2 + 1  =  31
automatically as soon as the slide appears in 

(11111)   =  (31)2 10 slide show view, while When Clicked option 
(d) (10001) will start the sound only when you click the 2

mouse.16 8 4 2 1
3. To insert your own sound in a slide, follow the 1 0 0 1 1

given steps :
16 + 0 +0 + 2 + 1  =  19

Step 1 : Open or navigate the slide on which 
(10011)   =  (19) you want to insert your own sound.2 10

Step 2 : Select the Insert tab.3. (a) 11001 (b) 10001

Step 3 : Click the drop-down arrow on the 10101 1110
Sound button in the Media Clips group. A pop-= (101110) = (11111)2 2

up menu appears on the screen. Select the 
(c) 11100 (d) 1001 Record Sound option from the pop-up menu.

10011 1111 Step 4 : The Record Sound dialog box appears. 
= (101111) = (11000) By default, the sound will be named ‘Recorded 2 2

Sound’.

1

3. Advanced Features of PowerPoint

Let’s Do Something

A. 1. (b), 2. (c), 3. (d), 4. (b), 5. (a)

B. 1. (F), 2. (F), 3. (T), 4. (F), 5. (T), 6. (F)

C. 1. Animation is the process where multiple 
images are displayed rapidly in a sequence 
such that the images appears to be in motion.

2.
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Step 5 : Press the red button to record, and Step 8 : Click on Apply To All button to apply 
square button to stop the recording. the selected effects on all the slides.

Step 6 : After recording of your sound, you 
can use the play button to listen to the recorded 
sound.

Step 7 : Click on OK button. A small speaker 
icon will appear on the slide.

4. The steps to print a presentation are :

Step 1 : Specify the slides to be printed.

Step 2 : Choose number of copies in the 
Number of copies box.

Step 3 : Specify the item that you want to print 
in Print what option.

Step 4 : You can make other changes in your To create a number series, follow the given 
printouts using Handouts option. steps :

Step 5 : After making desired changes, click Step 1 : Enter the first two values of the data 
on OK button. in the adjacent cells. The first two data values 

determine the increment value and the starting 5. Think about a cartoon film. When one scene 
number of the series.ends; another scene begins. For example, a 

scene can fade out into a new scene or the first Step 2 : Select the two cells.
scene slides off the screen as the second slides 

Step 3 : Click the AutoFill handle (a small 
in. The way one slide follows the other on the 

black square ‘   ’) in the lower right corner of 
screen is called transition. Such transitions are 

the selected cells and drag it to enclose the area 
also available in MS PowerPoint.

you want to fill with the number series.
6. To add slide transition to a slide, follow the 

Step 4 : Release the mouse button.
given steps :

4. The steps to apply border are as follows :
Step 1 : Click on the desired slide, to which 

Step 1 : Select the range of cells in the you want to add slide transition effect.
worksheet whose border style you want to 

Step 2 : Click on the Animations tab.
change.

Step 3 : By default, No Transition is applied to 
Step 2 : Click on Border button arrow in the 

each slide. Click on any transition effect from 
Font group on Home tab and select More 

the Transition to This Slide group.
Borders option from the list.

Step 4 : The current slide will display a 
Step 3 : Format Cells dialog box appears on 

preview of the selected effect.
the screen.

Step 5 : Select the desired speed from the 
Step 4 : Click on the Border tab in Format 

Transition Speed drop-down list.
Cells dialog box.

Step 6 : Click on the Transition Sound drop-
Step 5 : Choose the different options of your 

down arrow and select any sound effect of 
choice.

your choice.
Step 6 : Click on the OK button.

Step 7 : Click on the On Mouse Click 
5. The steps to format numbers are as follows :checkbox if you want to advance the slide 

manually by clicking the mouse or click on Step 1 : Select the cell or range of cells whose 
Automatically After checkbox if you want the data you want to format.
slide to advance automatically to the next one. Step 2 : Click on Number launcher button in 

4. Formatting Data in MS Excel

Let’s Do Something

A. 1. (b), 2. (c), 3. (d), 4. (a), 5. (c), 6. (c)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F), 6. (T)

C. 1. Alignment refers to the position in which data 
is placed with in the boundary of a cell.

2. The process of determining how data should be 
presented and how it will appear on a printed 
page is called formatting. Formatting changes 
the appearance of data but does not affect the 
actual cell value.

3.
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the Number group. When you use cell reference and change a 
number used in a formula, Excel will Step 3 : The Format Cells dialog box appears 
automatically redo the calculation for you. Let with the Number tab as an active tab.
us consider a few examples of reference.

Step 4 : Choose the category 
according to your choice. Under 
Number, you have the facility to 
choose the number of decimal 
places you want, you can decide to 
use a thousand separator for larger 
numbers, and you can decide how 
you want negative numbers to be 
represented.

Step 5 : After choosing options 
according to your choice, click on 
OK button. 

6. To change pattern and colour of 
the selected cells, follow the given 

3. To edit a formula in your worksheet, follow the steps :
given steps :

Step 1 : Select the cell or range of cells.
Step 1 : Double-click on the cell containing 

Step 2 : Click on Format button in the Cells 
the formula you want to change. The formula 

group on Home tab. A drop-down list appears 
appears in the formula bar.

on the screen. Click on Format Cells option.
Step 2 : Now you can edit the formula in the 

Step 3 : Format Cells dialog box appears on 
formula bar. Here, you want to see the 

the screen with Fill as an active tab.
addition, so replace the (*) operator with (+) 

Step 4 : Select a pattern from the Pattern Style operator.
drop-down list. The Sample box indicates how 

Step 3 : When you finish making the changes 
the pattern will look with the currently selected 

to the formula, press the Enter key.
colour.

4. Functions are predefined formulas which are 
Step 5 : You can also change the colour of the 

used to perform specific calculation.
pattern. Select the pattern colour from Pattern 

5. AutoSum feature is used for quickly summing Color drop-down list.
the data values stored in a row or column. This 

Step 6 : Click on OK button.
feature can be used by clicking AutoSum 
button, presented in the Editing group on 
Home tab.

6. Arranging a given set of data in a particular 
order is called sorting. This feature allows user 
to rearrange the given data in a specified order.

7. To sort data in Excel, follow the given steps :

Step 1 : Open the worksheet on which you 
want to perform sort operation.

Step 2 : Select any cell in the worksheet and It is convenient to use cell reference instead of 
click on Sort button in the Sort & Filter group actual data at the time of working with 
on Data tab.formula. For example, enter the formula ‘= A1 

+ A2’ instead of  ‘= 100 + 200’. Step 3 : The entire database will be selected 

5. Formulas in MS Excel

Let’s Do Something

A. 1. (b), 2. (a), 3. (c), 4. (b), 5. (d)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T), 6. (F)

C. 1. The expression which helps you to calculate 
and analyse the data in your worksheet is 
known as formula. A formula may contain cell 
addresses, operators and functions.

2.
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Cell/Range of Cells Reference

The cell in column B and row 1  B1

The range of cells in column A and row 
5 through 20 A5 : A20

The range of cells in row 10 and column A 
through J A10 : J10

All cells in column H H : H

All cells in row 5 5 : 5

All cells in column D through N D : N

The range of cells in column A through D and
row 20 through 30 A20 : D30



and the Sort dialog box appears. 7. Data validation is used to restrict the cell 
entries within a specified range.Step 4 : Select a field, for example, 

‘AVERAGE’ from the Sort by list box. 8. Follow the given steps to sort data :

Step 5 : Select the option of your choice in Step 1 : Enter the data in the worksheet.
Order list box. Step 2 : Select any cell in the data list.
Step 6 : By default, My data has headers Step 3 : Click on Sort button in the Sort & 
checkbox is selected. If you do not have a Filter group on Data tab. The entire database 
header row, you can uncheck this option. will get selected.
Step 7 : Click on OK button to apply sorting in Step 4 : The Sort dialog box appears. MS 
your data. Excel usually assumes that you have a header 

row, i.e., first row of the data source, which is 
the title or heading for the selected data and the 
corresponding option is already selected. If 
you do not have a header row, you can uncheck 
the option My data has headers.

Step 5 : Select a field : For example, ‘TOTAL’ 
from the Sort by list box.

Step 6 : Select the Largest to Smallest option 
in Order list box. By default, the Smallest to 
Largest option is selected. 

Step 7 : The sorted data appears.

The INPUT statement allows the user to enter 
the value when the program is running. This 

To add records using form, follow the given command will print and wait for the user to 
steps : enter the value and then assign this value to a 
Step 1 : Select any cell and click on Form variable. It is used like this :
button in the Quick Access Toolbar. The   Syntax : INPUT <Numeric or string variable 
Sheet1 dialog box appears on the screen. name>
Step 2 : Click on New button to add a new 2. REM statement is used to give remarks in a 
record in your database. program.
Step 3 : Here you can type the information for 3. PRINT command is the output statement that 
new record. is used to display the output on the computer 
Step 4 : Click on Close button to exit from screen.
data form. Example     PRINT ‘‘HI’’

5. AutoFilter and Advanced Filter. HI will be displayed on the output screen.
6. Conditional formatting means highlighting or 4. Output statement is used to display the output 

emphasizing selected cells on the basic of a on the computer screen.
criteria. It allows you to set rules on how the 

5. Do yourself.
cells should be formatted.

6. Advance Features of MS Excel

Let’s Do Something

A. 1. (d), 2. (a), 3. (a), 4. (c), 5. (d), 6. (d)

B. 1. (T), 2. (F), 3. (F), 4. (T), 5. (T), 6. (T)

C. 1. A database is a collection of inter–related data 
which is systematically organized and stored in 
a computer system. Organized data is easy to 
access and work with. Data organization is 
done using a specific data model. The model, 
widely used these days, is the relational model.

2. Sorting feature allows you to view data in 
7. QBASIC Statementsdifferent orders, i.e, Ascending or Descending. 

It is the most powerful feature of MS Excel. Let’s Do Something

3. Filtering is a quick and easy way to extract A. 1. (c), 2. (a), 3. (b), 4. (d), 5. (a)
certain records or rows from a database created B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (F)
in MS Excel. Thus, it allows you to selectively 

C. 1.
block out data that you don’t want to see.

4.
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8. QBASIC : Operators and Looping 9. QBASIC : Sound and Graphics
Statements Let’s Do Something

Let’s Do Something A. 1. (c), 2. (b), 3. (b), 4. (a), 5. (c)

A. 1. (c), 2. (b), 3. (d), 4. (a), 5. (d), 6. (b) B. 1. (F), 2. (F), 3. (T), 4. (T), 5. (T), 6. (F)

B. 1. (T), 2. (T), 3. (T), 4. (T), 5. (F) C. 1. Screen statement is used for selecting an 
appropriate screen mode for creating graphics C. 1. Relational operators are used to perform a 
in QBASIC. Its syntax is as follows :comparison between two values. The result of 

the comparison is either true or false. Syntax : SCREEN [Screen mode number]

Logical operators are used to either 2. Line statement is used to draw a triangle in 
concatenate or reverse condition. Logical QBASIC.
operators are useful when you need to check Example : 
multiple conditions.

2. Looping means repeated execution of a 
statement or a set of statements. A loop is said 
to be a set of instructions that are executed 
more than once in a program.

3. STEP clause in FOR-NEXT is used to change 
the increment value.

4. The three ways to execute loops in QBASIC 
are :

FOR...NEXT, DO.....LOOP, 
WHILE......WEND.

5.

10. Computer Virus

Let’s Do Something

A. 1. (b), 2. (c), 3. (a), 4. (b), 5. (d)

B. 1. (T), 2. (F), 3. (F), 4. (T), 5. (T)

C. 1. A computer virus is a destructive software 
created to harm a computer and damage its 
contents.

SCREEN 7

COLOR 15, 10

CLS

PRINT “A Triangle Using Line Statement’’

LINE (160, 30) — (250, 180), 2

LINE (250, 180) — (70, 180), 2

LINE (70, 180) — (160, 30), 2

END

3. BEEP and PLAY statements enables us to play 
music.

WHILE......WEND LOOP
4. LINE statement is used to draw a straight line 

Sometimes, a loop has to be executed 
between two points on the screen while 

repeatedly while a given condition remains 
CIRCLE statement is used to draw a circle, 

true. In such cases, W H I L E . . . . . . . . W E N D  
ellipse or arc of a circle.

statement is used.
5. To draw a circle in QBASIC, we use CIRCLE 

Syntax :WHILE condition
statement.

{
Syntax : CIRCLE (x, y), r, p

Statement(s)
Here, the co-ordinates x and y specify the 

} centre location of a circle on the screen, ‘r’ 
gives the value of the radius and ‘p’ specifies WEND
the colour code.6. FOR ...... NEXT LOOP

6. Sixteen (16) colours can be used in FOR...... NEXT is an iterative statement. It is a 
background or foreground in QBASIC.fixed loop. It facilitates repeated execution of 

some QBASIC statements, a set number of 
times. It provides an easy way to create a loop.

Syntax : FOR <control variable> = <initial 
value> TO <final value>

{statement}

NEXT <control variable>
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2. Computer–8
1. Computer Networking

Let’s Do Something

A. 1. (b), 2. (c), 3. (b), 4. (a), 5. (c)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (F), 6. (T)

C. 1. A computer network is a collection of 
computers and the relected devices connected 
using certain communication channels. These 
networks allow users to share the resources 
with other computers and also communicate 
between different machines.

2.

Trojan Horse

A Trojan Horse is a  malware, that is, a 
malicious software. It seems to perform a 
useful function, but actually performs 
destructive functions such as destroying the 
data stored in the computer, allowing an 
outsider illegal access to the system, etc. A 
Trojan horse usually does not replicate itself. 
Some well-known Trojans are Nuclear RAT, 
Bitfrost, Zlop, Mocmex, Beast, etc.

Worm

A Worm is a computer program that replicates 
itself very fast and disturbs entire network. It 

Reliability : Since multiple copies of enters to a computer system through infected e-
important files can be maintained and mails, reproduces itself, sends copies of itself 
transferred between systems, the network to other computers through a network and 
ensures that any critical task does not come to chokes the network. It also causes permanent 
a standstill or data is not lost if a machine stops loss of data. Some Worms that have brought 
working.networks down are Happy 99,  Code Red, 

Nimda, Storm, etc. Redundancy : Computer networks reduce the 
need for hard copies of all documents. By 3. An antivirus software is a software designed to 
sharing files over the network, the need to protect a  system from viruses. In order to be 
share paper copies of reports or any other effective, it must be run in the background at all 
information can be eliminated or greatly times. Antivirus software must be updated on a 
reduced.regular basis to ensure that the latest viruses are 

also covered. Scalability : Adding more and more 
computers to an existing network is not a 4. Program Virus, Boot Sector Virus, Macro 
cumbersome process. It just takes a few Virus.
minutes. Similarly, the entire network does not 5. • Frequent hanging of the system.
collapse if just one client computer stops 

• Displaying a change in data against the working.
filename in the directory, when a virus 

3. LAN : LAN stands for Local Area Network. modifies the file.
The LAN spans across a limited geographical 

• Deleting or damaging files. area like a computer lab, office building, 
6. Spyware is a type of Malware that is installed residential apartment or school and connects 

on computers and collects information about computers and devices in that area. Wired 
users without their knowledge. Spyware LANs use ethernet technology, phone lines, 
programs secretly monitor the user’s coaxial cables or power lines to connect the 
computing. They can collect various types of computers. Your computer lab is a classic 
personal information such as internet surfing example of LAN.
habits, visited web pages, and transmits that 

WAN : WAN stands for Wide Area Network. 
information in the background to someone 

It is a kind of network that covers large 
else. Sometimes, they also change computer-

geographical area across the countries or 
setting that results in slow connection speed 

continents. In WAN, two or more computers 
and wrong functionality of other programs. 

located at far away places are connected to 
Spyware can also collect information about e-

each other for communication.
mail addresses, passwords and even credit card 

4. A network topology is how computers, printers numbers.
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and other devices are connected in a particular are known as Octal Digits.
arrangement. It describes the layout of wires, 2. To convert an octal number into a binary 
devices and routing paths. It defines the number, follow the given steps :
arrangement patterns in which the terminals or 

Step 1 : Convert every octal digit into its 
nodes are connected with each other.

equivalent of 3 binary digits.
5. The Network Interface Card : A NIC is the 

Step 2 : Combine all binary digits and make a 
computer’s gateway to the network. It attaches 

group.
the computer to the network allowing it to 

3. Hexadecimal number system is made up of communicate with the other computers on the 
sixteen symbols, 0 to 9 and A to F. When this network.
system is in use, every number is formed using 

Modem : A device which is needed to 
0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E and F. 

translate between the analog phone line and 
Since formation of numbers involves the use of 

digital computer, is called a modem. Modems 
these sixteen symbols, the base of the 

are formally known as modulators 
hexadecimal number system is said to be 16. 

demodulators. It modulates a digital signal 
The symbols 0 to 9 and A to F are known as 

from the computer into an analog one to send 
Hexadecimal Digits.

data out over the phone line.
4. To convert a binary number into a hexadecimal 

6. Star Topology : One of the most popular 
number, follow the given steps :

topologies for Ethernet LANs is the star. It is 
Step 1 : Bunch binary digits into groups of easy to set up and it is relatively cheap. The 
four starting from the rightmost digit. star topology works by connecting each node 

to a central device. This central connection Step 2 : If the leftover binary digits do not add 
allows us to have a fully functioning network up to four, add 0s to the left.
even when other devices fail. The only real Step 3 : Convert every set of four binary digits 
threat to this topology is that if the central into its equivalent hexadecimal digit.
device goes down, the entire network goes 

5. To convert a decimal number into a down. Star topology is better suited for small 
hexadecimal number, follow the given steps :networks.
Step 1 : Divide the decimal number by 16. Ring Topology : In local area networks where 
Note down the quotient and the remainder.the ring topology is used, each computer is 
Step 2 : Divide the quotient obtained by 16 connected to the network in a closed loop or 
and note down the resulting quotient and ring. The signal passes through each machine 
remainder.or computer connected to the ring in one 

direction only. There is no central node in this Step 3 : Repeat the procedure till you reach a 
pattern of topology. The disadvantage of this quotient less than 16.
topology is even if one node fails, the whole 

Step 4 : List all the remainders moving from 
network stops working.

bottom to top.

Octal number system is made up of eight 
symbols, 0 to 7. When this system is in use, 
every number is formed using 0, 1, 2, 3, 4, 5, 6 
and 7. Since formation of numbers involves the 
use of these eight symbols. The symbols 0 to 7 

2. More on Number System

Let’s Do Something

A. 1. (c), 2. (a), 3. (d), 4. (c)

B. 1. (T), 2. (T), 3. (F), 4. (T), 5. (F), 6. (F)

C. 1.
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D. 1. (a) (100111010) (b) (101111101)2 2

100 111 010 101 111 101

4 7 2 5 7 5

= (472) = (575)8 8

(c) (11100010011) (d) (1110011)2 2

011 100 010 011 001 110 011

3 4 2 3 1 6 3

= (3423) = (163)8 8

0 0 0 0 0 0

0 0 0 0 0 0 0
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2. (a) (526) (b)(6773)8 8

   5    2    6    6    7    7    3
2 1 0 3 2 1 08 ×5 8 ×2 8 ×6 8 ×6 8 ×7 8 ×7 8 ×3

320  +  16  +  6 3072 + 448 + 56 + 3

= (344) = (3579)10 10

(c) (1243) (d) (54)8 8

1 2 4 3 5 4
3 2 1 0 1 0

8 ×1 8 ×2 8 ×4 8 ×3 8 ×4 8 ×4

512 + 128 +  32  +  3   32  +  4

= (675) = (36)10 10

3. (a) (001111001001) (b) (110010101111001)2 2

0011 1100 1001 0110 0101 0111 1001

  3   12   9   6   5   7   9

  3   C   9 = (6579)16

= (3C9)16

(c) (1011110110) (d) (11100011101)2 2

0010 1111 0110 0111 0001 1101

  2   15    6    7    1   13

  2    F    6    7    1    D

= (2F6) = (71D)16 16

4. (a) (12FC) (b) (643A2)16 16

   1    2    F    C 6 4 3 A 2

0001 0010 1111 1100 0110 0100 0011 1010 0010

= (0001001011111100) = (01100100001110100010)2 2

(c) (15FA) (d) (A36C)16 16

1 5 F A    A   3    6   C

0001 0101 1111 1010 1010 0011 0110 1100

= (0001010111111010) = (1010001101101100)2 2

5. (a) (687) (b) (796)10 10

16 687 16 796

16 42 15 F 16 49 12 C

16 2 10 A 16 3 1 1

0 2 2 0 0 3 3

= (2AF) = (31C)16 16

(c) (4991) (d) (2690)10 10

16 4991 16 2690

16 311 15 F 16 168 2 2

16 19 7 7 16 10 8 8

16 1 3 3 16 0 10 A

0 1 1

= (137F) = (A82)16 16

0

0

0

0 0

0

0



3. Creating Charts in MS Excel

Let’s Do Something

A. 1. (d), 2. (c), 3. (a), 4. (a), 5. (c)

B. 1. (F), 2. (F), 3. (F), 4. (T), 5. (T), 6. (F)

C. 1. A chart is a pictorial representation of data. 
Chart is an effective way to display data in 
pictorial representation of selected worksheet 
information.

2. MS Excel supports various types of charts. 
Some of them are Column Chart, Bar Chart, 
Line Chart, Pie Chart, Scatter Chart, Area 4. MS Access : An Introduction
Chart, Radar Chart, etc.

Let’s Do Something
3.

A. 1. (a), 2. (b), 3. (a), 4. (c), 5. (b), 6. (a)

B. 1. (T), 2. (F), 3. (F), 4. (T), 5. (T), 6. (F)

C. 1. A database is a systematic collection of 
interrelated data that is organized and stored in 
a computer system.

2.

the desired style. Observe the change in your 
chart. All the data labels, legend details, 
mentioned in the selected data range will be 
displayed in the chart.

Step 8 : You can also change the data range of 
your chart after creating it. To change the data 
range, right click on chart and click on Select 
Data from the shortcut menu. The Select Data 
Source dialog box appears.

Step 9 : Make changes according to your 
choice and click on OK button.

Bar Chart : This chart illustrates comparison 
among individual items. Categories are 
organized vertically, values horizontally, to 
focus on comparing the values and to place 
less emphasize on time. This is a chart with 
horizontal bars.

Radar Chart : In radar chart, each data series Database management systems have the 
has its own value axis from the center point. following advantages which encourage people 
There is a line which connects the value in the to use them to generate and maintain databases 
same data series. :

4. Data Points, Data Series, Chart Title, Data DBMS Reduces Duplication of Data : A 
Labels, Legend. DBMS stores data at a central location and 

5. Data Points : The graphs are based on the minimizes data redundancy, that is, duplication 
values of the worksheet. The values are known of data.
as data points. Data Series : The set of many DBMS Removes Inconsistencies : When the 
data entries, which comes from the same row same data is stored at multiple places, they 
or column in a worksheet, is called data series. may fail to match. A DBMS stores data at a 

6. To create a chart, follow the given steps : central location. Thus, it eliminates data 
inconsistencies by eliminating duplication of Step 1 : Create a new worksheet with the data.
data.

Step 2 : Select all the cells that will be in the 
DBMS Facilitates Data Sharing : A DBMS chart including headers.
stores data at a central location and makes data 

Step 3 : Click on the Insert tab.
available to more than one user at the same 

Step 4 : Click on any chart type in the Charts time.
group on Insert tab, say Column and select the 

DBMS Ensures Data Security : A DBMS 
chart sub-type from the displayed choices.

stores data at a central location and prevents 
Step 5 : The chart appears on the worksheet. A unauthorized access and manipulation of the 
new category named as Chart Tools appears on data. Thus, DBMS makes data secure.
the Title bar.

DBMS Ensures Data Integrity : A DBMS 
Step 6 : Select the desired layout from the places restrictions on the data entered in 
Chart Layouts group on the Design tab and specific fields and ensures that only valid data 
observe the change. is stored. Thus, DBMS gurantees data integrity.

Step 7 : Go to Chart Styles group and click on 3. Field : Each column of information in a table 
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is referred to as a field. It stores a particular 
category of information. For example, the 
column titled ‘NAME’ is a field that stores the 
names of students in a class. So, the 
information stored in a column is called field.

Record : Number of fields make one record. 
Each row of information is called a record. For 
example, Student’s Roll No., Name, Age and 
Address indicate one record of a student. The steps to create a table in design view are 

4. To create a blank database, follow the given as under :
steps : Step 1 : Open the database in which you want 
Step 1 : Open MS Access by clicking on Start to create a table.
> All Programs > Microsoft Office > Microsoft Step 2 : In Database window, select Create tab 
Office Access 2007. and click on Table Design button in the Tables 
Step 2 : MS Access opens with the ‘Getting group. The Table Design View window 
Started with Microsoft Office Access’ window. appears.

Step 3 : Select Blank Database template in the Step 3 : Here you can create whatever fields 
New Blank Database section. you like and select the data types for each 

field.Step 4 : A Blank Database task pane appears 
on the right side of the window that prompts The Table Design View window consists of 
you to create a file. two areas :

Step 5 : Specify the file name say, (a) The field grid pane, and
Students_Records, in the File Name text box. (b) The field properties pane.
Step 6 : Change the path from the Browse The field grid pane allows us to give the field 
button next to the File Name text box, if names and specify the data type. Some 
required. description with each field could also be given, 
Step 7 : Click on Create button. The database though this is optional.
will be created and the name of the database The field properties pane allows us to enter 
will be displayed on the Title bar. more details for each field like size, validation 

5. MS Access is a software designed by rule, etc.
Microsoft for creation and maintenance of Step 4 : Enter the first field name in Field 
databases. It is based on the relational database Name column. Press the Tab key to move to 
model. Hence, it is known as a relational Data Type column and select the suitable data 
database management system. type for its respective field.

6. The steps to open an already existing database Step 5 : Press the Tab key to move to the 
are : Description column. In this column, you can 
Step 1 : Select Open option of Office Button give any comment related to the field, This is 
drop-down menu. an optional step.

Step 2 : The Open window appears. Step 6 : Press the Tab key again and the cursor 
will move to the Field Name column in next Step 3 : Choose the location of the file.
row.

Step 4 : To open the desired file, double click 
Step 7 : Repeat this procedure until you have on the file name in the window or select the 
created all of your fields.file and click on the Open button.
Step 8 : After creating all your fields, press 
‘Ctrl + S’ key combination to save your file.

5. MS Access : Tables

Let’s Do Something

A. 1. (c), 2. (b), 3. (b), 4. (d), 5. (c), 6. (c)

B. 1. (F), 2. (T), 3. (T), 4. (T), 5. (F), 6. (T)

C. 1. A table is the combination of rows and 
columns. It is the fundamental building block 
of any database.

2.
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Step 9 : The Save As dialog box appears. Type problem solving, dynamic memory allocation, 
the Table Name and click on OK button. data types and co-operative multitasking.

Step 10 : A new dialog box appears prompting STRIPS : It is a language for expressing 
you to create a primary key. automated action sequences that can be 

followed by robots and other such machines. Step 11 : Click on No button.
The program expresses a set of actions to be 

3. In datasheet view, we enter the actual data i.e., 
performed to attain a certain goal. For each 

the records.
action pre-conditions and post-conditions are 

4. Design view allows more control over the specified.
table structure.

3. Fuzzy logic controllers have been developed 
5. To set primary key in a table, follow the given for automatic gear-boxes in automobiles. This 

steps : uses a method where the drivers of the 
automobiles need not bother about shifting the Step 1 : Select the field to be used as primary 
gears while driving. The program will take key.
care of that and will do gears shifting Step 2 : Click on the Primary Key button 
automatically. Thus Artificial Intelligence is present in the Tools group on Design tab.
useful in transportation.

6. Only text and number data type field size can 
4. Robots are preferred in certain industries than be changed; all other data types have the 

human bacause, when human are assigned predefined size. For text, change the Field Size 
repetitive jobs, they can cause accidents or property option by increasing or decreasing the 
make mistakes due to lapse of concentration. number of characters. In numeric field, change 
Robots have proven as an effective the General tab to any other in the properties 
replacement for humans in these kinds of jobs. pane.
They neither lose not make concentration 

7. To delete a field, follow the given steps : mistakes.
Step 1 : Double-click on the table to open it 5. AI helps in combat and training simulators. It 
and click on View button on Datasheet tab. is widely used to train air traffic controllers. 
Select Design View option from the drop-down With speech recognition software in AI, the air 
menu. traffic controllers are giving directions to the 
Step 2 : Select the field to be deleted by artificial pilots. AI-supported software helps in 
clicking on the field selector. creating conceptual designs for aircrafts. 

NASA created a software that could enable a Step 3 : Click on Delete Rows button in the 
damaged aircraft to fly until it finds a safe Tools group on Design tab.
landing place.

6. AI has been used successfully in fields like 
medical diagnosis, stock trading, robot control, 
finance, transportation, etc.

Artificial intelligence or AI is the intelligence 
of machines and the branch of computer 
science that aims to create it. In other words, it 
is the area of computer science focusing on 
creating machines that can behave in a way HTML is an acronym for Hyper Text Markup 
that human consider intelligent. Language. It is the language of the World Wide 

Web. It is the computer language used to create 2. Information Processing Language (IPL) : 
hyper text documents. Hyper text documents IPL was the first language developed for AI. Its 
are the documents that have hyperlinks. These features support programs that perform general 

6. Artificial Intelligence

Let’s Do Something

A. 1. (c), 2. (b), 3. (d), 4. (c), 5. (a)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (F), 6. (T) 7. Introduction to HTML
C. 1. Let’s Do Something

A. 1. (c), 2. (d), 3. (b), 4. (a), 5. (b)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (T), 6. (T)

C. 1.
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hyperlinks connect documents at 
different locations simply by 
clicking on hyperlinks. There is no 
set order of doing things. The 
movement from one document to 
another is hyper and not linear.

2. HTML is the most popular 
language for designing web pages 
and websites. HTML has the 
following features :

5. To view an HTML document, follow these • It is easy to learn and master.
steps :

• It allows text, images and videos to be 
Step 1 : Open Internet Explorer or any other displayed on a web page.
web browser.

• It determines how a web page with text, 
Step 2 : Press Ctrl + O key combination. The images and videos appears on the web 
Open dialog box will appear. Click on the browser. It delivers the contents to multiple 
Browse button. A dialog box will appear.platforms.

Step 3 : Choose the path where you have 3. (i) Container Tags : Container tags require 
stored your HTML document and select your an opening or ON tag and closing or OFF 
file. Click on Open button.tag.

6. The HEAD tag contains information about the OFF tags are written within the angular 
document, including its title, scripts used, style brackets, but using a slash before the 
definitions, document description and links to command.
pages that could be pre-loaded. This tag is 

For example :  <title>      HTML    </title>
nested within the HTML tag.

                        ON tag       text      OFF tag

(ii) Empty Tags : Empty tags have only a 
starting tag. For example,  <BR> tag is 
used to break a line in a web page. There is 
no closing tag for <BR>. Similarly,  
<IMG> tag inserts an image.

4. Each HTML file begins with <HTML> tag 
and ends with </HTML> tag. These are called 
the markers for the browser to identify the 
spots where the document starts and ends. 
Within these tags, HTML file is divided in two 
sections :

HEAD : The HEAD section contains 
information about the document that is not 
displayed on the web page.

BODY : The BODY section contains IMG tag is an empty tag that is used to insert 
everything that is displayed on the web page. It an image in a web page. The value that it takes 
includes text, graphics, etc. is the location of the file containing the image.

So, the basic structure of an HTML page is : Syntax :  <IMG SRC = ‘‘Location of the image’’>

Any text placed between the comment tags will 
be ignored by the browser. It helps in editing or 

8. Tags in HTML

Let’s Do Something

A. 1. (b), 2. (a), 3. (c), 4. (a), 5. (d), 6. (c)

B. 1. (T), 2. (T), 3. (T), 4. (F), 5. (F), 6. (F)

C. 1. A web page is made up of different elements 
each of which is defined by HTML code or 
tag. An HTML tag always begins with a less 
than sign ‘<’ and ends with a greater than ‘>’ 
sign. For example, the tag that makes text bold 
is B. It is tagged as <B> within the text. This 
tag is written before the text you want to bold. 
This is called opening tag or ON tag. In order 
to end the bold effect, you have to use a 
closing or an OFF tag.

2.
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<HTML>

<HEAD>

<TITLE>Title of the page is written here </TITLE>    HEAD tag

</HEAD>            

<BODY>

The other tags which define the page are included here.

</BODY>

</HTML>

 H
T

M
L

 tag BODY

tag



viewing the HTML code of a web page. It is a 
useful tag for programmers. Different types of list can be created in an 

Syntax : <COMMENT> .......... </COMMENT> HTML document. They are :

3. SIZE, WIDTH and COLOR are the three 1. Unordered List
attributes used with horizontal rule tag. 2. Ordered List

4. Bold tag is used to give the Bold effect to the 3. Definition List.
text. It is a container element.

Unordered List <UL> Tag
Syntax :  <B>The text is bold </B>

Unordered list or bulleted list is used when the 
Italic tag is used to give the Italic effect to the items in the list are not required to be in a 
text. It is a container element. specific order. An unordered list is enclosed 

Syntax :  <I>The text is italic </I> within the  <UL>..........</UL> tags. Each item 
in the list is given with the help of <LI> tag. 5. The browser does not recognize formatting. If 
The ‘TYPE’ attribute of the <UL> tag allows you want to start a new line, you need to insert 
you to specify the type of bullets you want for a line break <BR> tag. This tag has no end tag. 
the list items. This attribute can take three 

Syntax : <BR>
values : Disc, Square and Circle to produce 

<HR> tag is used to display a horizontal line dark circle bullets, square bullets, and white 
across the web page. It is an empty element circle bullets before the list items, respectively.
that has no end tag.

Ordered List <OL> Tag
Syntax :   <HR>

An ordered list is a list where the items are in a 
6. Some of the attributes of body tag are : specific order and need to be numbered. This 

kind of list could be used to give a list of items BGCOLOR : BGCOLOR attribute is used to 
or to number the steps in a procedure. An change the background colour of a web page. 
ordered list is enclosed within the  You can use the BGCOLOR attribute like this :
<OL>..........</OL> tags. Each item in the list Syntax : <BODY BGCOLOR=“Green”>
is given here also with the help of <LI> tag.

TEXT : TEXT attribute is used to set the 
Syntax :  <OL  START = ‘Value’ TYPE = ‘1’ / ‘A’ / colour of the text in the document. You can use 

‘a’ / ‘I’ / ‘i’>TEXT attribute like this :
Definition List TagSyntax :  <BODY TEXT = ‘‘White’’>
A definition list tag is used to build a list of TOPMARGIN : This attribute is used to set 
items, where each item has some block of text the top margin of a web page. It is given within 
acting as a definition.the  tag with any value such as 60. This will 

2. <TR> tag defines a horizontal row of cells display the text 60 pixels away from the top of 
while <TD> tag specifies an individual block the page.
or cell in a table row.Syntax :  <BODY TOPMARGIN=60> 

3. To create a hyperlink, <A> tag is used. The LEFTMARGIN : This attribute is used to set 
HREF attribute of the <A> tag stores the the left margin of a web page. The value of left 
reference of the document that is to be linked. margin accordingly keeps the text away from 
The text that appears on the hyperlink is the left corner of a page. 
enclosed between the starting tag <A>  and 

Syntax :  <BODY  LEFTMARGIN = 50> ending tag </A>.

Syntax : <A HREF = ‘‘Document Name’’> Hyperlink 
Text </A>

4. Cellpadding lets you define the distance 
between a cell boundary and its contents while 

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T), 6. (T)

C. 1.

9. Creating Lists and Tables in HTML

Let’s Do Something

A. 1. (a), 2. (d), 3. (c), 4. (d), 5. (a)
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cellspacing lets you add space between cells.

5. Do yourself.

6. HTML allows you to nest a list within another 
list. The list that lies within another list is 
called a nested list. The browser automatically 

Flash is a powerful animation software uses different bullets or numbering systems for 
package developed by Macromedia. Flash the next level of indentation for the nested list. 
provides a versatile and easy way to create You can nest an ordered list within an 
animation that consists of images, sound and unordered list and vice versa.
video with various effects. Flash is extremely 

The following HTML coding shows you how 
useful for developing highly interactive 

the nesting of lists works :
websites, online advertisements, computer 

<HTML> games and contents for various mobile devices.

<HEAD> 2. The Property Inspector is a panel that displays 
the properties of the selected object. The list of <TITLE> Creating Nested List </TITLE>
properties also vary in the Property Inspector.</HEAD>

3. Different components of a flash window are : <BODY>
Toolbox, Timeline, Panels, Layer Window, 

<CENTER> Versions of software Stage and Property Inspector.
</CENTER>

4. Brush tool has the following 3 options :
<UL Type = ‘SQUARE’>

Brush Mode Modifier : On clicking, a drop-
<LI>Microsoft OFFICE down menu appears, which provides 5 modes 
<OL TYPE = ‘1’> for applying strokes.

<LI>MS WORD Brush Size : Clicking this, displays a drop-
down menu which provides a range of preset <LI>MS POWERPOINT
available brush sizes.

<LI>MS EXCEL
Brush Shape : Clicking this, displays a drop-

<LI>MS ACCESS
down menu with all possible shapes— circle, 

</OL> square, rectangle, etc.
</UL> 5. The steps to draw with pencil tool are :
<UL>Type = ‘CIRCLE’> Step 1 :  Select the Pencil Tool.
<LI>  OPERATING SYSTEM Step 2 :  In the Property Inspector, select 
<OLType = ‘1’> stroke colour, line thickness and style.

<LI>WINDOWS 95 Step 3 :  Select a drawing mode such as 
Straighten, Smooth, Ink under Options in the <LI>WINDOWS 98
Tools Panel.

<LI>WINDOWS XP
Step 4 :  Click on the stage and drag to draw 

<LI>WINDOWS 7
lines.

</OL>
6. Line tool is used to draw straight lines in flash.

</UL>

</BODY>

</HTML>

Internet, especially the world wide web part of 

10. Introducing Flash

Let’s Do Something

A. 1. (a), 2. (b), 3. (d), 4. (b), 5. (c), 6. (d)

B. 1. (T), 2. (T), 3. (F), 4. (F), 5. (T)

C. 1.

11. Internet Services and E–commerce

Let’s Do Something

A. 1. (b), 2. (a), 3. (c), 4. (d), 5. (b)

B. 1. (F), 2. (T), 3. (T), 4. (T), 5. (T), 6. (F)

C. 1.
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it, is a storehouse of huge amount of numbers of companies and business 
information on virtually any conceivable topic organizations have set up their own websites 
of public interest. Thus, Internet has made it providing details of their products and services 
easier to access and share information, which and how to buy them. You can visit these sites 
can be in the form of text, pictures, audio, or and buy virtually anything on the internet.
video. To extract information from the internet 6. Business-to-Business : This mode refers to a 
is called information retrieval. company selling or buying products or services 

2. For video conferencing, we need a PC with from other companies.
internet connectivity, a digital camera properly Consumer-to-Consumer : Consumer-to-
configured and connected to PC and a video Consumer e commerce refers to auction sites 
conferencing software such as Microsoft Net where individual consumers put up items and 
Meeting. other individual consumers bid for it. For 

3. Searching for information on the internet or example : ebay, yahoo auction, etc.
simply exploring the internet is commonly 7. Digital Middlemen refers to a company which 
referred to as surfing. provides information about several companies 

4. Three ways are : on a single website. These companies collects 
information from other companies about the • Finding information using search engine
same type of products (bikes, computer 

• Finding people on the internet
hardware, cars, etc), or services (travel and 

• Education through internet tourism, etc). A commission is charged for 
every sale or purchase by the company hosting 5.  E–commerce refers to the buying and selling 
the website.of things over the internet. These days, a large 
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